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P

Preface 

The Watson™ TSQ™ Module application is part of the Thermo mass spectrometry data 
system. 

This user guide describes how to use the Watson application features to create and send a run 
to the TSQ Module application and perform data review on results files sent from the TSQ 
Module application.

This user guide also describes how to use the TSQ Module application features to accept a run 
request from the Watson application, acquire samples, and return the acquired data to the 
Watson data storage. 

To suggest changes to documentation or to Help

Complete a brief survey about this document by clicking the link below.
Thank you in advance for your help.

Contents

• Related Documentation

• Special Notices

• System Requirements

• Contacting Us
Thermo Scientific Watson TSQ Module User Guide vii
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Preface
Related Documentation
Documentation for the TSQ Module application includes Help and the TSQ Module User 
Guide as a PDF file.

To view the TSQ Module User Guide

Go to Start > All Programs > Thermo Watson TSQ Module > Manuals > Watson TSQ 
Module User Manual.

To open the TSQ Module Help

From the TSQ Module application, choose Help > Watson TSQ Module Help. 

To find a particular topic, use the Help Contents, Index, or Search panes.

For more information, including upcoming application notes, visit www.thermo.com.

Special Notices
This guide includes the following types of special notices:

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.
viii Watson TSQ Module User Guide Thermo Scientific
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Preface
System Requirements
Your system must meet these minimum requirements.

System Requirements

PC • 2 GHz processor with 1 GB RAM
• CD-ROM drive
• Video card and monitor capable of 1280×1024 resolution (XGA)
• 75 GB on the C: drive 
• NTFS format

Instrument • TSQ Quantum™
– Or – 

• TSQ Vantage™

Software • Microsoft™ Windows™ XP Professional with Service Pack 3
• (Optional) Xcalibur™ 2.1.0
• Adobe Acrobat 9.0
• TSQ 2.1.0
• LC Devices 2.2.1
• Watson 7.4
• Foundation 1.0.1 (available on the Xcalibur 2.1.0 CD)
• (Optional) LCquan (required to create .lqn method files)
Thermo Scientific Watson TSQ Module User Guide ix



Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. 

To contact Technical Support

Find software updates and utilities to download at mssupport.thermo.com.

To contact Customer Service for ordering information

To copy manuals from the Internet

Go to mssupport.thermo.com and click Customer Manuals in the left margin of the 
window. 

To suggest changes to documentation or to Help

• Fill out a reader survey online at www.thermo.com/lcms-techpubs.

• Send an e-mail message to the Technical Publications Editor at 
techpubs-lcms@thermofisher.com.

Phone 800-532-4752

Fax 561-688-8736

E-mail us.techsupport.analyze@thermofisher.com

Knowledge base www.thermokb.com

Phone 800-532-4752

Fax 561-688-8731

E-mail us.customer-support.analyze@thermofisher.com

Web site www.thermo.com/ms

mailto:us.techsupport.analyze@thermofisher.com
http://www.thermokb.com
http://mssupport.thermo.com
http://www.thermo.com/finnigan
http://mssupport.thermo.com
http://www.thermo.com/lcms-techpubs
mailto:techpubs-lcms@thermofisher.com


1

Introduction

This chapter describes the general features and workflows of the TSQ Module application and 
the TSQ Module-specific features of the Watson application.

Watson Feature Summary
The TSQ Module application is designed for routine tandem liquid chromatography-mass 
spectrometry (LC/MS) bioanalysis of samples. The TSQ Module application can be used 
with Thermo Fisher triple quadrupole LC/MS systems such as the Quantum and Vantage 
LC/MS products. After an analytical method has been developed, the TSQ Module 
application can be used to validate the method and perform routine bioanalysis of samples.

The TSQ Module-specific features within the Watson application include:

• The Watson work list, tuning (*.tun) and method (*.meth) files are directly exported to 
the TSQ Module application

• The LC/MS tuning (*.tun) and method (*.meth) files are stored inside the Watson 
application database

• The LC/MS peak processing parameters are stored inside the Watson application database

• Raw data is stored inside the Watson application database

• Chromatogram review, re-injection selection and submission, and peak integration and 
re-integration occur within the Watson application 

• Real-time run peak review occurs in the TSQ Module application

• Real-time run status is obtained in the Watson application 

Contents

• Watson Feature Summary

• TSQ Module Feature Summary

• Watson/LCquan-Xcalibur/TSQ Module Workflow

• Watson/LCquan-Xcalibur/TSQ Module Sequence of Steps

• Watson/TSQ Module/Watson Run Management
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1 Introduction
TSQ Module Feature Summary
• Raw data is archived within the Watson application study archive

• A single audit trail of data acquisition (performed in the TSQ Module application) and 
run review processing is stored in the Watson application 

TSQ Module Feature Summary 
The TSQ Module application is a software solution for use in bioanalytical quantitation. The 
features of the TSQ Module application provide support for the acquisition of run requests 
submitted by the Watson application. The TSQ Module application features include:

• Submission of run requests to an instrument

• Editing of samples in a run

• Real-time view of runs in progress or in the Acquisition Queue

• The ability to start, stop, pause, and cancel an acquisition in the queues with audit 
messages sent to the Watson application

• Security provisioning against the Watson LIMS

• Secure and verified transmissions of the data files using a proprietary schema

• Run manager that holds multiple run requests from the Watson application so that users 
can visualize the current load on a system, select the next run to acquire, and (when 
necessary) send an unacquired run back to the Watson application for assignment to a 
different instrument

• A processing method exporter to extract processing information from an Xcalibur 
processing method or LCquan workbook and upload these parameters

• General purpose communication service layer between the TSQ Module application and 
the Watson application that supports multiple instances and databases

• Re-injecting samples without creating a new run in the Watson application
2 Watson TSQ Module User Guide Thermo Scientific
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Watson/LCquan-Xcalibur/TSQ Module Workflow
Watson/LCquan-Xcalibur/TSQ Module Workflow
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Watson/LCquan-Xcalibur/TSQ Module Sequence of Steps
Watson/LCquan-Xcalibur/TSQ Module Sequence of Steps
The following table outlines user-specific steps using the Watson application, the Xcalibur 
application, and the TSQ Module application. 

Table 1. Watson/Xcalibur/TSQ Module key steps

Step Instructions

Create a peak integration instrument 
interface.

Completed by the System Manager. For more 
information, refer to the TSQ Module System 
Manager’s Guide.

Create or clone the instrument stack. See “Creating an Instrument Stack” on page 7.

Create the tune, method, and 
processing parameters files.

Completed externally to the Watson application 
in the LCquan or Xcalibur applications. For more 
information, refer to the LCquan User Guide or 
the Xcalibur documentation set.

Setup the master assay. See “Setting up the Master Assay” on page 13.

Create or open a Watson study. See “Working with a Watson Study” on page 16.

Copy the master assay to the study 
assay.

See “Working with a Watson Study” on page 16.

Create a new run with the study assay 
and add samples to the work list.

See “Working with a Watson Study” on page 16.

Create a sequence file. See “Working with a Watson Study” on page 16.

Send the run to the TSQ Module 
application.

See “Working with a Watson Study” on page 16.

When necessary, modify the run 
parameters (injection volume or 
position).

See “Editing a Run” on page 41.

Start data acquisition. See “Acquiring a Run” on page 45.

Monitor peaks in real time in the TSQ 
Module application.

See “Monitoring the Run Status” on page 48.

Monitor run status in real time in the 
Watson application.

See “Reviewing Runs” on page 59.

Review the run. See “Reviewing Runs” on page 59.

Change the peak processing 
parameters.

See “Reintegrating Chromatograms” on page 63.

Review internal standards. See “Reviewing Internal Standards and 
Performing Regression” on page 71.
4 Watson TSQ Module User Guide Thermo Scientific
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Watson/TSQ Module/Watson Run Management
Watson/TSQ Module/Watson Run Management
The TSQ Module application workflow moves runs between three locations: the Watson 
application where runs originate, the TSQ Module Run Manager view that receives each run, 
and the TSQ Module Acquisition Queue where runs are acquired.

• A run sent from the Watson application enters the TSQ Module Run Manager view. The 
run status is Pending. 

• When you submit the run for acquisition, the run is placed in the Acquisition Queue and 
the status in the Run Manager view changes to Submitted. 

If the run is the first run in the Acquisition Queue, acquisition immediately begins and 
the status in the Run Manager view is Acquiring.

• When the acquisition begins, the status changes to Acquiring. 

Filter sample types. See “Reviewing Internal Standards and 
Performing Regression” on page 71.

When necessary, select runs to reinject. See “Re-injecting a Run from the Watson 
Application” on page 106.

Review and accept the results of the 
reinjected run.

See “Reviewing Internal Standards and 
Performing Regression” on page 71.

Accept the run. See “Reviewing Internal Standards and 
Performing Regression” on page 71.

Perform standard regression. See “Reviewing Internal Standards and 
Performing Regression” on page 71.

Generate and print reports. See “Printing Capabilities” on page 84.

Review the audit trail. See “Audit Reports” on page 80.

Step Instructions

Watson Acquisition QueueRun Manager view

Run Run
(Samples 1-n)

Sample (1-n)

XML (1-n) Data (1-n)

Instrument
Thermo Scientific Watson TSQ Module User Guide 5



1 Introduction
Watson/TSQ Module/Watson Run Management
• When the acquisition finishes, the status for the run changes to Completed. The data for 
the run returns to the Watson application in XML format and the run is removed from 
both the Run Manager view and the Acquisition Queue.

• While in the Run Manager view, you can cancel a run. A canceled run returns to the 
Watson application and is removed from the Run Manager view.

• While in the Acquisition Queue, you can remove a run and return it to the Run Manager 
view with a Stopped or Pending status. To move a run from the Acquisition Queue and 
return it to the Watson application, you must first return the run to the Run Manager 
view and then cancel it from there.

Table 2. Run Manager view status

Status Description

Pending The run arrived from the Watson application and awaits 
acquisition. This run could have been submitted to the 
Acquisition Queue and returned to the Run Manager view 
before it began acquiring.

Submitted The run is assigned for acquisition but is not currently acquiring. 
The run is in the Acquisition Queue.

Acquiring The run has progressed to the top of the Acquisition Queue and 
is currently acquiring. 

Completed The acquisition has finished running and the run data was 
returned to the Watson application. 

Completed runs might not always be observed in the Run 
Manager view. When the TSQ Module application finishes 
sending the results of the last completed sample to the Watson 
application, it marks the run as Completed and quickly removes 
the run from the queue.

Paused The run is assigned to an instrument and is currently acquiring, 
but has been paused and waits between samples.

Stopped The run was assigned to an instrument and was acquiring, but 
was removed from the Acquisition Queue.
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2

Watson: Submitting Runs to the TSQ Module

This chapter provides information about setting up a run and submitting it to the TSQ 
Module application.

Creating a Peak Integration Instrument
The system manager sets up the peak integration instrument that is part of the Watson TSQ 
Module application configuration process. 

This section describes the following tasks:

• Creating an Instrument Stack

• Specifying Devices

Creating an Instrument Stack

The following procedures provide instructions to create, clone, edit, or delete an instrument 
stack.

Use the following procedures:

• To create the instrument stack

• To clone an instrument stack

• To edit an instrument stack

• To delete an instrument stack

Contents

• Creating a Peak Integration Instrument

• Tune, Method, and Processing Method Files in LCquan and Xcalibur

• Setting up the Master Assay

• Working with a Watson Study
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2 Watson: Submitting Runs to the TSQ Module
Creating a Peak Integration Instrument
To create the instrument stack

1. Choose Options > Instrument Inventory. 

The Instrument Setup window opens.

2. From the Instrument Setup window, click the Peak Integration instrument and then click 
Add to create (define) the stack. 

The Create Instrument Stack dialog box opens.

Figure 1. Create Instrument Stack dialog box

3. In the Create Instrument Stack dialog box, enter an Instrument Stack name. 

4. (Optional) Enter an autosampler or comment.

5. Click Save.

To clone an instrument stack

1. Choose Options > Instrument Inventory to open the Instrument Setup window.

2. Select an instrument and then click Clone. 

The Clone Instrument dialog box opens, populated with the stack information.

Figure 2. Clone Instrument dialog box
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Creating a Peak Integration Instrument
3. To modify stack information, click the appropriate field.

4. To test the URL, click Test URL. 

If the Watson application is unable to access the URL, you receive an error message.

5. To specify a location, click Choose and select a location.

6. Do one of the following:

• To save the cloned instrument, click Save. 

–Or–

• To exit without saving any changes, click Cancel.

To edit an instrument stack

1. Choose Options > Instrument Inventory.

The Instrument Setup window opens.

2. Select an instrument stack and click Edit.

The Edit Instrument dialog box opens, populated with the instrument information. 

3. To modify instrument information, click the appropriate field.

4. Do one of the following:

• To delete save the device, click Save. 

–Or–

• To exit without making any changes, click Cancel.

To delete an instrument stack

1. Choose Options > Instrument Inventory.

The Instrument Setup window opens.

2. Select an instrument stack and click Delete.

A confirmation message opens. 

3. Do one of the following:

• To delete the instrument stack, click OK. 

–Or–

• To exit without making any changes, click No.
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Creating a Peak Integration Instrument
Specifying Devices

Use the following procedures:

• To create a device

• To clone a device

• To edit a device

• To delete a device

To create a device

1. Choose Options > Instrument Inventory to open the Instrument Setup window.

2. Select the Peak Integration instrument.

3. Click Add at the bottom of the Devices pane. 

The Create Device dialog box opens.

4. Enter a Device Name and Device Type. 

5. (Optional) Type the Manufacturer, Model, Serial Number, and Barcode.

6. Do one of the following:

• To save the device, click Save. 

–Or–

• To exit without creating a device, click Cancel.

To clone a device

1. Choose Options > Instrument Inventory.

The Instrument Setup window opens.

2. Select a device and then click Clone.

The Clone Devices dialog box opens, populated with the device information. 

3. To modify device information, click the appropriate fields.
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Creating a Peak Integration Instrument
Figure 3. Clone Device dialog box

4. Do one of the following:

• To save the device, click Save. 

–Or–

• To exit without cloning the device, click Cancel.

To edit a device

1. Choose Options > Instrument Inventory.

The Instrument Setup window opens.

2. Select a device and click Edit.

The Edit Device dialog box opens, populated with the device information. 

3. To modify the device information, click the appropriate fields.

4. Do one of the following:

• To save changes to the device, click Save. 

–Or–

• To exit without making any changes, click Cancel.
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Tune, Method, and Processing Method Files in LCquan and Xcalibur
To delete a device

1. Choose Options > Instrument Inventory.

The Instrument Setup window opens.

2. Select a device and click Delete.

A confirmation message opens. 

3. Do one of the following:

• To delete the device, click OK. 

–Or–

• To exit without making any changes, click No.

Tune, Method, and Processing Method Files in LCquan and Xcalibur
This section provides a list of tune, method, and processing method files in Xcalibur and 
LCquan. Use the LCquan LDK software to convert the .lqn or .pmd file to XML format.
Table 3. Xcalibur and LCquan tune, method, and processing parameter files

File extension File description

Xcalibur

*.pmd Processing QC levels Stds, component names, and integration 
parameters

*.TSQTune Tune parameters, mass spec amount of gas, amount of heat, and so on

*.meth Instrument method file, LC parameters, autosampler (A/S) settings, 
pump settings, mass spec transitions (SRMs)

LCquan

*.lqn Combination of .pmd and .meth files

*.TSQTune Tune parameters, mass spec settings, amount of gas, amount of heat 

Note  The Tune and Method files are closely associated with each other and form a 
matched pair. 
In LCquan, export the .TSQTune and .lqn files.
–Or–
In Xcalibur, export the .TSQTune, .meth, and .pmd files.
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Setting up the Master Assay
Setting up the Master Assay
This section provides the steps required when setting up the master assay. For more 
information about the master assay, refer to the Watson User Manual. While many steps follow 
the standard Watson application workflow, for runs to be submitted to the TSQ Module 
application, there are some differences. For example, the Instrument page is available only 
when you configure a Peak Integration instrument. Use the Instrument page to submit the 
run to the TSQ Module application.

Use the following procedures:

• To set up the Instruments page in the Assay view

• To add instrument-method associations

To set up the Instruments page in the Assay view

Complete the following process in the Master or Study Assay so that the definition is 
copied for each run assay. 

1. Click the Assay tab. 

2. Select LC/MS as the Assay type.

3. Click the Details tab. 

4. Select Peak Integration as the Instrument type.

The Instrument tab is activated in the Assay view.
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Setting up the Master Assay
Figure 4. Instruments page in the Assay view

This page contains three panes: Top (untitled), Instrument Files, and Processing Method 
Details.

5. In the Processing Method Details pane, use the Analyte/IS Name row to associate a 
parameter component with an analyte. 

Each cell contains a list of analytes and internal standards defined in the assay from which 
you select the analyte that matches the identified component (column header).

To add instrument-method associations

1. From the Master Assay, click the Instrument tab. 

2. In the top section, click Add to open the Add Instrument-Method Association dialog 
box.
14 Watson TSQ Module User Guide Thermo Scientific



 2 Watson: Submitting Runs to the TSQ Module
Setting up the Master Assay
Figure 5. Add Instrument-Method Association dialog box

3. From this dialog box, select the instrument group and stack defined in the Instrument 
Inventory dialog box.

4. Type a description in the Description box.

5. Upload Analysis Tune, Analysis Method, and Processing Parameters files by clicking the 
corresponding buttons. 

If necessary, click Clear to clear the fields.

Similarly, you can upload or clear Startup Tune, Startup Method, Shutdown Tune, and 
Shutdown Method files.

6. Click OK in the Add Instrument-Method Association dialog box.

7. Click Save in the Assay view.

• When you are in LCquan, import the saved .TSQTune, .lqn, and XML files.

• When you are in Xcalibur, import the saved .TSQTune, .meth, and XML files.

8. Click the Standards tab. 

9. Set the Injection Volume.

This field is required input for TSQ type assays. This injection volume is sent to the 
instrument for runs using this assay. 

Note  You can use the Watson application to associate multiple method files with an 
assay or instrument by repeating these steps and saving the changes when you are 
finished.
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Working with a Watson Study
The following procedures provide instructions for working with a study in the Watson 
application. For additional information, refer to the Watson User Manual.

Use the following procedures:

• To open a study

• To create a study

• To copy the master assay to the study assay

• To create a new run with the study assay

• To add samples to the work list

• To review the Plate Report page when planning an analytical run

• To create a sequence file

• To send the run to the TSQ Module application

To open a study

1. From the Watson application main menu, choose File > Study. 

The Study dialog box opens. Use this dialog box to create a new study or to work with an 
existing study within a project. You can also work with any recent studies listed at the end 
of the File menu. 

2. Select a study.

For more information, refer to the File Menu chapter in the Watson User Manual.

To create a study

1. From the Watson application main menu, choose File > Study. 

The Study dialog box opens.

2. Click Create.

3. Enter values in the fields and assign the study to the correct project. 

If you have not created the project for this study, click Cancel and create the project by 
choosing File > Project.

4. Click Save to save the study information. 

The Assign Many Users to a Single Study Form opens.

5. Assign appropriate users to the study by selecting them and then clicking -> (right-arrow 
button). 
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6. Click Save.

For more information, refer to the Study Actions chapter in the Watson User Manual.

7. From the Design menu, do the following:

a. Choose Design Study. 

b. Specify the Subject Groups, Subject, Treatments, Biological Matrices, and Nominal 
Times necessary for the study.

c. Click Accept when finished.

d. Choose Subjects. 

e. Complete your updates and click Save.

f. Choose Treatments.

g. Complete your updates and click Save.

For more information, refer to the Design Menu chapter in the Watson User Manual.

8. Choose Tracking > Sample Entry.

The Sample Entry dialog box opens. 

9. Select samples and click Save when complete. 

You may use only samples whose Sample Condition is OK in an Analytical Run.

For more information, refer to the Tracking Menu chapter in the Watson User Manual.

To copy the master assay to the study assay

1. Choose Analytical > Copy Master Assay.

2. Select one or more assays to be used for this study from the list of master assays.

If the appropriate assay has not been set up for this project, exit and create a new master 
assay by choosing File > Master Assay. 

3. Select Save to copy the master assay to this study. 

4. Copy the master assay to the study assay.

To create a new run with the study assay

1. Choose Analytical > Plan Analytical Run.

The Analytical Runs dialog box opens. 

2. Click Create.

3. On the Analytical Run Info page, specify the type of run and the assay to be used.
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To add samples to the work list

1. Click the Worklist tab. 

2. Add assay samples, study samples, and user-defined samples. 

3. Double-check volumes, aliquot/dilution factors, or both. 

4. Make sure the work list is in the order you want to inject the samples. 

5. When you are finished, click Save.

6. From the Analytical Runs dialog box, click Exit.

To review the Plate Report page when planning an analytical run

Click the Plate Report tab. 

The Plate Report page lists the samples with their sequence and identifier. It also shows 
the well positions in the plate map. These are carried to the TSQ Module application 
with run submittal.

To create a sequence file

1. Choose Analytical > Analytical Run Actions.

2. Select the analytical run to use for creating the sequence file.

3. Click Sequence File.

The Windows File dialog box opens. 

4. Select the appropriate file path and name of the sequence file to be created.

To send the run to the TSQ Module application

1. Choose Analytical > Analytical Run Actions.

2. From the list, click the run you want to send. 

3. Click Submit Run.

The Select Instrument to Run dialog box opens. 

4. Select the instrument and click OK.

For more information, refer to the Analytical Menu chapter in the Watson User Manual.



3

TSQ Module: System Administration

This chapter describes the TSQ Module tools and functions used primarily by system 
administrators, how the TSQ Module application communicates with the Watson 
application, and the types of actions that are audited.

Managing the Environments.xml File
In the Environments.xml file, the administrator assigns user-friendly names to the Watson 
application Web addresses. When a user logs onto the TSQ Module application, the system 
queries for available databases. 

• When the administrator assigns a name to a Watson application Web address in the 
Environments.xml file, the user-friendly name is displayed in the logon screen Database 
menu.

• When the administrator does not assign a name in the to the Watson application Web 
address in the Environments.xml file, the complete URL is displayed in the logon screen 
Database menu.

The Environments.xml file is located in the following directory:

C:\Documents and Settings\All Users\Application Data\Watson TSQ Module

Contents

• Managing the Environments.xml File

• Communicating with the Watson Application

• Exporting Method Files to a Common Folder

• Auditing

• Using E-Signatures
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Communicating with the Watson Application
Any new installation of the TSQ Module application preserves the edits to the 
Environments.xml file. Changes to the Environments.xml file are not apparent in the logon 
screen until you restart your computer and the TSQ Module application. The following is a 
sample Environments.xml file:

Where:
?xml version="1.0" encoding="utf-8" ? is a typical XML header.
Environments is a group or collection of Environment nodes.
Environment is the node type name.
address is the http address of the Watson application server.
other is the friendly name to use for that Watson application server.
SystemAudit optionally sends system-level audit logs to this server for acquisition events.

Communicating with the Watson Application
The TSQ Module application continuously communicates with the Watson application.

• When you edit the sample parameters in the TSQ Module application, it sends the edits 
to the Watson application. The TSQ Module application authenticates every edit in the 
Run Setup view and sends an audit trail to the Watson application.

• As each sample completes acquisition, the TSQ Module application returns the resulting 
data to the Watson application in XML format along with any new auditing information 
for the run.

• After the TSQ Module application passes the sample data to the Watson application 
database and the Watson application acknowledges receipt of the data, the TSQ Module 
application deletes any related temporary data from the local system.

• The TSQ Module application continues to send audit records to the Watson application 
until the acquisition service reports that the run is complete. 

• When the acquisition service reports that the run is finished, the TSQ Module 
application sends a final notification to the Watson application. This notification includes 
the Completed status of the run, the completion time, and any audit items that occurred 
after the last sample completed.

<?xml version="1.0" encoding="utf-8" ?>
<Environments>
<Environment address="http://localhost:9000" other="Host9000" SystemAudit="1"/>
<Environment address="http://localhost:9001" other="Host9001" SystemAudit=""/>
<Environment address="http://localhost:9002" other="Host9002"/>
</Environments>
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Exporting Method Files to a Common Folder
Use the Watson TSQ Module Method Exporter application (Method Exporter) to convert 
processing parameters from an Xcalibur processing method (.pmd) or an LCquan workbook 
(.lqn) to XML format and export the parameters to a common folder where Watson users can 
access them. 

You can use the Method Exporter application on any system to export Xcalibur .pmd files. To 
export LCquan .lqn files, first install the LCquan software including the LCquan 
Development Kit (LDK). The Method Exporter application exports all required LCquan 
parameters. See “Exported LCquan Parameters” on page 23.

You can use the Method Exporter application to export instrument method (.meth) files and 
tune (.TSQTune) files. You can also use the Method Exporter application to group instrument 
method and tune files in a single directory with the exported processing file. This simplifies 
uploading the files to the Watson application.

To open the Watson TSQ Module Method Exporter application

Choose Start > Programs > Thermo Watson TSQ Module >Watson TSQ Module 
Method Exporter.

The Watson TSQ Module Method Exporter opens. See “Thermo Watson TSQ Module 
Method Exporter” on page 22.

To export files to a common folder

The Watson application requires each of these files, but you can export any combination 
of method files in a single session. 

1. In the Method Exporter application, browse to the Xcalibur or LCquan processing 
method file that you want to export and click Open.

2. Browse to the instrument method file you want to export and click Open.

3. Browse to the tune file that you want to export and click Open.

4. Browse to the folder where you want the exported files to be written and click Open.

5. When you have identified all the files you want to export, click Export.

The Method Exporter application converts the processing method files to XML format 
and writes all the specified method files to the target folder.

A confirmation box lists all the files that were exported.

Note  For exported LCquan or Xcalibur methods, ICIS is the only integration type 
allowed and MS is the only detector allowed.
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6. Click OK.

The Method Exporter application remains open. You can export additional files to the 
common folder.

7. When you have finished exporting method files, click Exit.

The Method Exporter application closes.

Thermo Watson TSQ Module Method Exporter

Table 4. Thermo Watson TSQ Module Method Exporter parameters  (Sheet 1 of 2)

Parameter Description

Source files

Xcalibur (*.pmd) or 
LCquan (*.lqn) filename

Path to the Xcalibur or LCquan processing file to convert to 
XML format and export to a common folder.
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Exported LCquan Parameters

When you export an LCquan (.lqn) processing method, the following parameters are included 
for each component in the exported file:

• Component name
• Detector type
• Smoothing points
• Number of mass ranges
• Mass ranges
• Trace type (Mass range or TIC; Base peak is converted to mass range, if present, or TIC)
• Filter
• Adjust expected RT
• User entered RT
• Search window
• Display width
• Peak detection algorithm (ICIS only)
• Baseline window
• Area noise factor
• Peak noise factor
• ICIS Constrain peak width
• ICIS Peak height percentage
• ICIS tailing factor
• Peak identification: Locate method or peak detection index
• ICIS noise method
• ICIS calculate noise as RMS
• ICIS Minimum peak width
• ICIS Multiplet resolution
• ICIS Area tail extension
• ICIS Area scan window

Instrument Method 
(*.meth) filename

Path to the instrument method file to export to a common 
folder.

Tune (*.TSQTune) filename Path to the tune file to export to a common folder. 

Target folder for all 
exported files

Path to the common folder in which exported files are saved.

Export Converts the .pmd or .lqn file to XML format and copies all 
specified files to the target folder.

Exit Closes the Thermo Watson TSQ Module Method Exporter 
application without exporting any files.

Help Opens the Thermo Watson TSQ Module Method Exporter 
Help.

Table 4. Thermo Watson TSQ Module Method Exporter parameters  (Sheet 2 of 2)

Parameter, continued Description
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Auditing
The TSQ Module application immediately transmits system-level audit records, such as 
instrument errors, to the Watson application. 

The application collects and packages run-level audit records with run-result or run-complete 
XML data for a particular run. Audit records are delayed until a result or run-complete 
package is transmitted to the Watson application. A run must be in acquisition or canceled 
and returned to the Watson application before the TSQ Module application transmits the 
XML packages and audit records to the Watson application.

When there is no network connection to the Watson application, the TSQ Module server 
locally buffers system-level, result/run-complete audit packages for later transmission when 
the network is restored. 

User permissions facilitate auditing and are set on the Watson application side. The TSQ 
Module user has permissions at both the system level and the run level.

Audit Trail

The TSQ Module application creates an audit trail for the following actions:

User actions

• Expired sessions or logoffs

• Successful and unsuccessful logins

• Successful and unsuccessful E-signatures

• Activities on locked accounts

• Updates to sample injection volume, position, or comments

• Updates to run observation

• Runs submitted for acquisition

• Runs paused, stopped, or restarted in the Acquisition Queue

• Runs canceled in the Run Manager view

System events

• Instrument errors 

• System-level audits sent to the Watson application URLs
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User Permissions

The TSQ Module user has permissions at both the system level and the run level.

The TSQ Module application user system-level permissions:

• Log onto the Watson TSQ Module application.

• Manage the Run Manager view.

The TSQ Module application user run-level permissions:

• Submit a run for acquisition.

• Edit samples (injection volume, position, comment).

• Edit run information (enter additional comment or change acquisition options).

• Save an edited run.

• Cancel a run in the Run Manager view.

• Stop/pause/resume a run in acquisition.

• Remove a run from the Acquisition Queue.

Using E-Signatures 
You can set the TSQ Module application to request an electronic signature from a user when 
the run requires it. The attempted action (for example, saving an edited run) cannot be 
completed until the user provides a password and submits the electronic signature.

The requirement for an electronic signature is set in the Watson application. You can require 
an electronic signature when a user edits samples and saves a run in the Setup mode or when a 
user enters an additional comment and submits a run in the Acquire mode.

To submit an electronic signature

The end user follows these instructions:

1. Enter your user credentials or ask your supervisor to enter credentials.

User credentials are the same as your TSQ Module login and password.

2. Accept the default reason or enter your own reason for the operation.

3. Click OK.

The requested operation is completed. In addition to the type of operation and the reason 
for the operation, the Watson application audit trail records the date, time, and user 
credentials.
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Electronic Signature dialog box

 

Table 5. Electronic Signature parameters

Parameter Description

The following operation... Lists the operation that requires an electronic signature. This 
requirements is specified in the run XML data.

User Credentials

User Name The Watson login name for the user.

Password The Watson password for the user.

Reason Explanation for the action. Default is the same as the 
attempted operation.

OK Approves the user name and password, closes the Electronic 
Signature dialog box, completes the requested operation, and 
places an entry in the audit trail.

Cancel Closes the Electronic Signature dialog box, without 
completing the requested operation, and places an entry in the 
audit trail.
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TSQ Module: Getting Started

This chapter describes how to set up the TSQ Module application and log in to a session.

Setting up in the Watson Application
Each run is identified by the database, project, and study to which it belongs. A study 
contains design information about the subject, treatment, sampling times, and planning of 
analytic runs. The project and study names are displayed in the Run Name columns of the 
TSQ Module application queues.

The assay method for a run is defined in the Watson application. The creation date of the 
assay is displayed in the Assay Date columns of the TSQ Module application queues.

For detailed information about setting up runs in the Watson application, see Chapter 2, 
“Watson: Submitting Runs to the TSQ Module.” 

Starting the TSQ Module Application
Follow these instructions to install and start the TSQ Module application.

Use the following procedures:

• To set up and install the TSQ Module application

• To start the TSQ Module application

• To log in to the Thermo Watson TSQ Module application

To set up and install the TSQ Module application

1. To install the Xcalibur 2.1 application and your TSQ instrument driver, follow the 
instructions on the included CDs.

2. Install the driver for your LC pump and autosampler.

Contents

• Setting up in the Watson Application

• Starting the TSQ Module Application
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Starting the TSQ Module Application
3. Insert the Watson TSQ Module CD in the drive and follow the on-screen instructions.

If the install windows don’t automatically appear, navigate to the Xinstall.exe file and 
launch it.

To start the TSQ Module application

1. Configure your instruments.

You cannot configure your instruments while the TSQ Module application is running.

2. Double-click the TSQ Module application icon on your desktop, or go to Start > All 
Programs > Thermo Watson TSQ Module > Watson TSQ Module. 

The Thermo Watson TSQ Module login screen opens.

Table 6. Login screen parameters

Parameter Description

Login Name The user’s Watson login name.

Password The user’s Watson password.

Database The Watson environment URL or the friendly name assigned 
in the Environments.xml file.
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To log in to the Thermo Watson TSQ Module application

Each database is assigned to specific users. You cannot log in to a database that is not 
assigned to you, and you cannot log in to your assigned database unless there is at least 
one run assigned to you in the TSQ Module application.

1. Enter your Login Name.

2. Enter your Password.

3. Select your Database from the menu.

One of the following could happen:

• There are no databases to select from in the menu.

This means there are no runs in the TSQ Module Run Manager view. You cannot log 
in to the database unless there is at least one run in the queue.

• The database list might include databases that are not assigned to you. If you select 
one of these databases, you get the following error message:

To correct the problem, click OK in the error message and do one of the following:

– If you think you made a mistake in your login or password, re-enter them.

– If you made a mistake in the database you selected, select another database.

– If you think you should have access to the database you chose, contact your 
system administrator.

4. When you have correctly specified a login name, password, and database, click OK.

The Run Select view opens. See “Run Select View” on page 30.

You are ready to begin managing and acquiring your assigned runs. For detailed 
information about starting an acquisition from the Run Select view, see “Selecting a Run” 
on page 34.
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5

TSQ Module: Acquiring Data

This chapter describes the functions of the TSQ Module application: selecting a run, 
managing a run, editing a run setup, acquiring a run, and monitoring the run status.

Contents

• The Basic Workflow

• Selecting a Run

• Managing a Run

• Editing a Run

• Acquiring a Run

• Monitoring the Run Status
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The Basic Workflow
A routine workflow uses all modes of the TSQ Module application: Select, Manage, Setup, 
Acquire, and Status.

To watch a video of this basic workflow, see Basic Workflow Video.

Select
(Run Select view)

Manage
(Run Manager view)

Setup
(Run Edit view)

Acquire
(Run Edit view)

Status
(Run Status view)

Run request 
from Watson

Manage
(Run Manager view)
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Basic Workflow Video

The following video demonstrates a typical TSQ Module application session. 
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Selecting a Run
When you first start the TSQ Module application, the Run Select view opens. All runs 
assigned to you within the current database are listed. During this session, all runs received by 
the TSQ Module application for your current login and database are added to the list.

Use the following procedures:

• To select a run

• To monitor the run status

• To add or remove columns

To select a run

In the Run Select view, double-click anywhere in the row of the run.

The Run Edit view in the Setup mode opens.

The Sample Type, Sample ID, and Level are not editable columns, as indicated by the 
blue background. The Position, Injection Volume, and Comment columns are editable.

From the Run Edit view, you can modify the editable parameters before you submit the 
run for acquisition. Refer to “Editing a Run” on page 41.

To monitor the run status

Until a run completes and is returned to the Watson application, you can monitor the 
status in the Run Select view. The status can be any of the following:

• Pending – The run arrived from the Watson application and is assigned to the 
instrument at this workstation.

Tip  To return to the Run Select view from any other view, click the application 
button in the upper left corner and choose Select from the menu.
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• Submitted – A TSQ Module application user has submitted this run to the 
Acquisition Queue but is not currently acquiring.

• Acquiring – The run has progressed to the top of the Acquisition Queue and is 
currently acquiring. 

• Paused – The run was assigned to an instrument and was acquiring, but has been 
paused and is waiting between samples.

• Stopped – The run was assigned to an instrument and was acquiring, but was 
removed from the Acquisition Queue.

• Completed – The run has completed acquisition. 

To add or remove columns

1. Click the Column Selector icon  in the upper left corner of the view.

The Column Selector dialog box opens.

2. Check the box before a field name to display that column, or uncheck the box before a 
field name to remove that column from the display.

This action is immediately implemented in your display and retained throughout your 
session, but the column choices are not saved when you exit the TSQ Module 
application.

3. When you are finished adding or removing columns, click the red X in the upper right 
corner to close the Column Selector dialog box.

Note  Completed runs might not always be observed in the Run Manager view. 
When the TSQ Module application finishes sending the results of the last 
completed sample to the Watson application, it marks the run as Completed and 
quickly removes the run from the Run Manager view.
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Managing a Run
The Run Manager view in the Manage mode displays all runs sent from the Watson 
application. 

Use the following procedures:

• To display the Run Manager view

• To monitor the run status

• To add or remove columns

• To cancel a run and return it to the Watson application

• To cancel multiple runs

• To select a run for acquisition

To display the Run Manager view

From any view, click Manage.

The Run Manager view in the Manage mode displays all runs sent from the Watson 
application, but only the runs assigned to your database are available to you. See “Manage 
Mode” on page 39.

To monitor the run status

Until a run completes and is returned to the Watson application, you can monitor the 
status in the TSQ Module Run Manager view. The status can be any of the following:

• Pending – The run arrived from the Watson application and is assigned to the instrument 
at this workstation.

• Submitted – A TSQ Module application user has submitted this run to the Acquisition 
Queue but is not currently acquiring.

• Acquiring – The run has progressed to the top of the Acquisition Queue and is currently 
acquiring. 

• Paused – The run has been assigned to an instrument and is currently acquiring, but has 
been paused and is waiting between samples.

• Stopped – The run has been assigned to an instrument and was acquiring, but was 
removed from the Acquisition Queue.

• Completed – The run has completed acquisition. 

Note  Completed runs might not always be observed in the Run Manager view. 
When the TSQ Module application finishes sending the results of the last completed 
sample to the Watson application, it marks the run as Completed and quickly 
removes the run from the Run Manager view.
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To add or remove columns

1. Click the Column Selector icon  in the upper left corner of the view.

The Column Selector dialog box opens.

2. Check the box before a field name to display that column, or uncheck the box before a 
field name to remove that column from the display.

This action is immediately implemented in your display and retained throughout your 
session, but the column choices are not saved when you exit the TSQ Module 
application.

3. When you are finished adding or removing columns, click the red X in the upper right 
corner to close the Column Selector dialog box.

To cancel a run and return it to the Watson application

To cancel a run, the status of the run must be either Pending or Stopped.

1. Click the row selection tab to select the run and enable the Cancel Run button.

2. Click Cancel Run.

The system confirms that you want to cancel the run and return it to the Watson 
application.

Click here
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3. Click Yes to confirm the cancellation.

• If the run had not begun acquisition, a Watson user can assign the run to a different 
instrument and re-send the run to the TSQ Module application.

• If the run had begun acquisition, a Watson user can re-send the run to the TSQ 
Module application, but it must be assigned to the same local instrument. The entire 
run must complete acquisition on a single instrument. A run returned for reinjection 
cannot be assigned to a different instrument. 

To cancel multiple runs

You can cancel Pending or Stopped runs and return the runs to the Watson application. 
You cannot cancel Acquiring or Submitted runs.

1. Select the runs you want to cancel and return to the Watson application. 

• Use the Shift key to select a group of consecutive runs.

• Use the Ctrl key to choose a group of non-consecutive runs.

The selected rows are highlighted.

2. Choose Cancel Run.

The system confirms that you want to cancel multiple runs and return them to the 
Watson application. The system warns that you cannot cancel Acquiring or Submitted 
runs.

3. Click Yes to confirm the cancellation.

The runs are immediately returned to the Watson application. Any selected Acquiring or 
Submitted runs that remain in the Run Manager view are no longer selected.

To select a run for acquisition

1. Select a run and click Select Run, or double-click in the run row.

The Run Edit view opens and displays each sample in the run. From this view you can 
edit the run before you submit it for acquisition.

For detailed information about editing the run before you submit it, see “Editing a Run” 
on page 41.

Selected rows
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2. To submit the run, click Acquire.

The Run Edit view in the Acquire mode displays the samples for the run. You cannot edit 
the samples from the Acquire mode. 

The Acquire options in the Acquire mode provide parameters for submitting a run for 
acquisition. For details about using the Acquire options to submit a run, see “Acquiring a 
Run” on page 45.

Manage Mode 

Table 7.  Manage mode parameters  (Sheet 1 of 2)

Command Description

Function buttons

Select Run Opens the Setup view for the highlighted run.

Cancel Run Removes the highlighted run from the view and returns the run to 
the Watson application.
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Run Manager 
columns

Status Status of each run: Pending, Submitted, Acquiring, Paused, 
Stopped, or Completed.

• Pending - The run arrived from the Watson application and 
awaits acquisition. This run could have been submitted to the 
Acquisition Queue and returned to the Run Manager view 
before it began acquiring.

• Submitted - The run is assigned for acquisition but is not 
currently acquiring. The run is in the Acquisition Queue.

• Acquiring - The run has progressed to the top of the 
Acquisition Queue and is currently acquiring. 

• Paused - The run has been assigned to an instrument and is 
currently acquiring, but has been paused and is waiting 
between samples.

• Stopped - The run was assigned for acquisition and was 
acquiring, but a user action moved it back to the Run 
Manager view.

• Completed - The run has completed acquisition.

Completed runs might not always be observed in the Run 
Manager view. When the TSQ Module application finishes 
sending the results of the last completed sample to the Watson 
application, it marks the run as Completed and quickly 
removes the run from the Run Manager view.

Database The Watson database or the friendly name assigned in the 
Environments.xml file.

Run Name A combination of the project, study, and run ID as defined in the 
Watson application.

Samples Number of samples in the run.

Receive Date Timestamp when run was received.

Assay Date Timestamp when assay method was created.

Description Comments entered by a Watson user.

Extraction Date Timestamp when samples in the run were extracted.

Analyst The user who created the run in the Watson application.

Observations The Watson application user comments.

Table 7.  Manage mode parameters  (Sheet 2 of 2)

Command Description
40 Watson TSQ Module User Guide Thermo Scientific



 5 TSQ Module: Acquiring Data
Editing a Run
Editing a Run
When you edit the parameters of a run in the TSQ Module application, the edits are sent 
back to the Watson application. Every action in the Run Edit view in the Setup mode is 
authenticated and an audit trail is sent to the Watson application.

Use the following procedures:

• To edit the samples in a run

• To automatically enter Position column values

• To automatically enter Injection Volume column values

To edit the samples in a run

1. Do one of the following to open the Run Edit view in the Setup mode:

• From the Run Select view, double-click any column in the run row.

–Or–

• From the Run Manager view, do one of the following:

• Double-click any cell in the run row.

–Or–

• Click anywhere in the run row to select it and click Select Run.

The Run Edit view in the Setup mode opens. See “Setup Mode” on page 44.

In this view, only the Position, Injection Volume, and Comment columns are editable. 

2. (Optional) To specify a tray name, click Options in the ribbon above the view and select 
a tray name from the list.

When you use an autosampler, you must select a tray name with which to validate the vial 
or well position. Positions are usually provided by the Watson application.

3. To edit the Position column, click the current position value and type a new value.

If you specify an incorrect position, an error message shows you the correct syntax to use.
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4. To edit the Injection Volume column, click the current injection volume value and type a 
new value.

5. To edit the Comment column, click in the column and type a comment.

This field is limited to 100 characters.

6. To save the edits, click Save Run.

The Save Run button is enabled only after you edit a column value in the run.

To automatically enter Position column values 

To use this feature, you must have an autosampler configured. If you specify an incorrect 
position for your configured autosampler, an error message shows you the correct syntax 
to use.

1. Enter a value for the first row in the fill down sequence.

Observe that this row is highlighted as the selected row. You can begin the sequence from 
any row in the column. 

2. Right-click outside this cell but still in the Position column and choose Auto Fill Down.

The column values are incremented starting with the value in the selected row and ending 
with the last row in the run. 

The TSQ Module application knows the number of positions configured in your 
autosampler and numbers the positions accordingly. See Example 1.

You can repeatedly use the Auto Fill Down command to create multiple sequences. See 
Example 2.

Note  The Save Run command can be specified to require an electronic signature. See 
“Using E-Signatures” on page 25.
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Example 1

The TSQ Module application knows sequential order of the positions configured in your 
autosampler and numbers the positions accordingly.

Example 2

You can repeatedly use the Auto Fill Down command to create multiple sequences.

To automatically enter Injection Volume column values 

Right-click the Injection Volume column and choose Auto Copy Down.

The first row value is copied to all rows. 
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Setup Mode

Table 8. Setup mode parameters

Command Description

Function buttons

Save Run Saves the edits you made to the run. The Save Run command can 
be specified to require an electronic signature. See “Using 
E-Signatures” on page 25.

Run columns

Sample Type Defines how the Watson application processes the sample data. 
Each sample must be classified as one of the following sample 
types: 

• Unknown
• Blank
• QC (quality control)
• Standard

Sample ID An alphanumeric string of characters that can be used to uniquely 
identify the sample.

Level The level defined for a calibration sample or quality control 
sample. 

Position Sample position number in the autosampler, usually provided by 
the Watson application.

Injection Volume (μL) Microliters to be injected. 
• When you have an autosampler configured, the injection 

volume is validated against the allowable range specified by the 
autosampler.

• When you do not have an autosampler configured, you can 
enter a range of 0.1-1000.

Comment Optional information about the sample.
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Acquiring a Run
From the Acquire mode, you can start the acquisition of a run and specify the real-time 
display settings. 

To submit a run

1. From the Run Edit view in the Setup mode of the run you want to acquire, click Acquire.

The Acquire mode opens. 

The Run Edit view in the Acquire mode displays the samples for the run. You cannot edit 
the samples from the Acquire mode. 

The Acquire options in the Acquire mode provide parameters for submitting a run for 
acquisition. See “Acquire Options” on page 46.

2. If this run was previously stopped and removed from the Acquisition Queue, you can 
specify the first and last samples you want to acquire.

By default, all samples are acquired.

3. To insert this run into the Acquisition Queue ahead of any submitted non-acquiring 
runs, check Priority Run.

4. (Optional) Add an additional comment. 

5. (Optional) Specify an instrument startup or shutdown method:

• To run a startup method before the run starts, check Startup Method.

• To run a shutdown method after the run is completed, check Shutdown Method.

6. Specify the status of the system after data acquisition by selecting one of the system power 
schemes: On, Standby, or Off.

The default is On.

7. To submit the run to the Acquisition Queue, click Run.

• If this is the first run in the queue, the acquisition begins and the status of the run is 
reported as Acquiring in the Run Manager view.

• If there are other runs in the queue, the run is added to the queue and the status of 
the run is reported as Submitted in the Run Manager view.

Note  If you made changes to the setup and did not explicitly save them, a dialog box 
asks if you want to save the changes now.

Note  When you submit a priority run, it goes into the Acquisition Queue ahead of all 
other submitted, non-acquiring priority runs. 
Thermo Scientific Watson TSQ Module User Guide 45



5 TSQ Module: Acquiring Data
Acquiring a Run
When acquisition for a run is complete, the run is removed from the Run Manager view 
and the results are returned to the Watson application.

For detailed information about monitoring a run as it acquires, see “Monitoring the Run 
Status” on page 48. 

Acquire Options 

Table 9. Acquire options parameters  (Sheet 1 of 2)

Parameter Description

Acquire samples Displays the first and last samples to acquire. Available only for a 
previously Stopped run.

Priority Run Inserts this run into the Acquisition Queue ahead of all submitted, 
non-acquiring runs.

Additional comment A comment that is returned to the Watson application in the run 
report.

Instrument Method

Startup Method Specifies that the TSQ Module application runs the startup 
method specified in the run data before the run starts. No data is 
acquired by this method, and no autosampler injection takes place. 
This feature is not available for all devices.
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Shutdown Method Specifies that the TSQ Module application runs the shutdown 
method specified in the run data after the run has completed. No 
data is acquired by this method, and no autosampler injection 
takes place. This feature is not available for all devices.

System power scheme

On Keeps the system in the On state when the current run is 
completed. When On is selected, you can begin another run 
without waiting. All power and flows are maintained at 
operational levels. Default: On

Standby Keeps the system in the Standby state when the current run is 
completed. When you select Standby, you can begin another run 
with only a short delay between runs. 

Some devices do not have a Standby feature. For devices with this 
feature, a power-saving or consumable-saving mode is entered and 
the devices can be switched back on in approximately 15 minutes 
or less. Depending the instrument, this state turns gas and liquid 
flows to Off, but maintains heaters and other subsystems in an On 
state so that there is no warm-up time required when you change 
from Standby to On. 

Off Keeps the system in the Off state when the current run is 
completed. The Off state indicates that all power to the 
instrument, which can be controlled by the TSQ Module 
application, is turned Off. This includes power to all heaters and 
most subassemblies, but in some cases not all subassemblies. 

Some devices do not have an Off feature. For devices that do have 
this feature, a power-saving or consumable-saving mode is entered 
and you can manually switch the devices back on. 

When several runs are queued, the system power scheme of the last 
submitted run is used. 

Caution The Off state does not guarantee that all voltages are 
turned off nor does it indicate that all heated components are at 
room temperature. To perform maintenance on an instrument, 
refer to the hardware manual for your instrument. 

Function buttons

Run Starts the acquisition for the currently selected run and opens the 
Status view.

Table 9. Acquire options parameters  (Sheet 2 of 2)

Parameter Description
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Monitoring the Run Status
When you begin acquisition for a run from the Acquire mode, the Run Status view in the 
Status mode is displayed. 

You can return to the Status mode at any time as long as there are runs in the Acquisition 
Queue.

To return to the Status mode

To return to the Status mode, click Status.

From the Run Status view in the Status mode, you can 

• Start, stop, or pause an acquisition

• Monitor the run manager and instrument status

• Monitor the Acquisition Queue

• Control the real-time display

This section contains information about the following:

• Run Status View Control Buttons

• Run Status

• Instrument Status

• Acquisition Queue

• Display Options

• Pausing/Stopping/Canceling Runs
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Figure 6. Run Status view in the Status mode

Run Status View Control Buttons

The control buttons on the Status view let you control the acquisition process.

To start, stop, or pause an acquisition

• To start an acquisition or resume an acquisition that has been paused, click .

• To pause an acquisition after the current sample has been completely acquired, click .

To resume the acquisition, click  again.

Control buttons Display options

Acquisition Queue Chromatogram display Spectrum display
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• To immediately stop the current acquisition, click .

Acquisition for the current sample stops and the sample is considered complete. The 
acquisition for the run is paused.

• To pause the real-time display during an acquisition, click .

The acquisition continues; only the display is paused. 

To resume the real-time display, click  again.

• To display the Spectrum pane below the Chromatogram pane, click .

To hide the Spectrum pane, click  again.

For a detailed explanation of how pausing, stopping, or canceling runs is managed, refer to 
“Pausing/Stopping/Canceling Runs” on page 55.

Run Status

The Run Status page on the Run Status view displays information about the run currently 
being acquired.

Figure 7. Run Status page

Table 10. Run Status parameters (Sheet 1 of 2)

Parameter Description

Run Manager 

state Reports the current status of the system. 

Run Name Displays the run currently being acquired.

Sample ID Displays a unique alphanumeric name assigned to each 
sample. The assigned name can be up to 50 characters long. 

Position Displays the position (including a tray name, when applicable) 
in the autosampler tray of the current sample. This readback 
value is displayed only if your LC provides this information 
under direct control. This value is not displayed if your LC is 
under contact closure control. 
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Instrument Status

Each instrument sends its own status information to the Run Status view. This is an example 
of a simulator status.

Acquisition Queue

The Acquisition Queue page on the Run Status view displays information about all the runs 
in the Acquisition Queue. 

Instruments

The readback state of each configured instrument appears on the Run Status page. 

Shortcut Menu
Right-click to display the instrument’s shortcut menu.

Turn Device On Puts an instrument in the On state.

Turn Device Standby Puts an instrument in the Standby state. 

Turn Device Off Puts an instrument in the Off state.

Table 10. Run Status parameters (Sheet 2 of 2)

Parameter Description

acquisition complete
currently acquiring
waiting for acquisition
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Real-time Display

The Run Status view lets you observe real-time display during an acquisition. The displayed 
“time windows” correspond to the time segments defined in the instrument method. 

Figure 8. Chromatogram display
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Figure 9. Spectrum trace display

Display Options

On the Status mode display options pane, you can specify display options for the current 
real-time display. The settings for these options remain each time you log in to the TSQ 
Module application. 

To specify display settings

You can change the display settings at any time while an acquisition is running. 

1. To display the chromatograms for all compounds, select Method-defined traces.

2. To display the spectrum trace, select Show spectrum trace.

3. Choose one of the following spectrum trace options:

• To continuously update the spectrum trace of the most current scan, select 
Continuous update.

– Or –

• To display the spectrum trace of the selected peak, select Manual select.

After you apply these settings, click on a peak in the real-time display.

4. To specify the range for the real-time display, do the following:

a. Select User-defined RT range (min).

b. Enter a value for the beginning of the range.

c. Enter a value for the end of the range.

5. To update the current display with your settings, click Apply Settings.

The changes are immediately applied. 
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To zoom in on the real-time display

1. Drag your cursor in the chromatogram or spectrum trace panes to define a region to 
zoom in. 

2. To return to the original display, right-click and choose Reset Scaling from the menu.

Status Mode Display Options 

Table 11. Status mode parameters  (Sheet 1 of 2)

Parameters Description

Method-defined traces Displays real-time chromatograms corresponding to the 
components defined in the processing method. When the 
component traces are turned off, the total ion current (TIC) trace 
is displayed.

Show spectrum trace Displays the mass spectrum in the spectrum pane. 

Continuous update Continuously updates the spectrum trace to show the most current 
scan.

Manual select Display the spectrum trace of the currently selected peak.

User-defined RT range Displays chromatograms with a time range between the times 
specified in the Min RT and Max RT boxes.

Min The start time of the chromatogram traces. 

Note The Min box becomes active only when you select 
User-defined RT range. 
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Pausing/Stopping/Canceling Runs 

A run submitted by the Watson application enters the TSQ Module Run Manager view with 
the status Pending. From the Run Manager view, you can submit a run to the Acquisition 
Queue or cancel the run, sending it back to the Watson application.

When you submit a run for acquisition, the run moves to the Acquisition Queue and the 
status in the Run Manager view is Acquiring. From the Acquisition Queue, you can pause a 
run and resume it, stop the currently acquiring sample and continue to the next sample, or 
remove a run from the Acquisition Queue—sending it back to the Run Manager view.

Use the following procedures:

• To stop an acquiring sample

• To pause a run

• To remove a currently acquiring run from the Acquisition Queue

• To remove a non-acquiring run from the Acquisition Queue

• To cancel a run in the Run Manager view

To stop an acquiring sample

You can stop acquisition of an individual sample in the Acquisition Queue. When a 
sample is stopped, the system considers it complete and the XML data is packaged and 
returned to the Watson application. You cannot resume a stopped sample.

1. To stop the acquisition of the current sample, click Stop .

• The acquisition stops for the currently acquiring sample and the run pauses. 

• The run status in the status in the Run Manager view is Paused.

• The pause button is red indicating that it is ready to resume with the next queued 
sample.

Max The end time of the chromatogram traces. 

Note The Max box becomes active only when you select 
User-defined RT range. 

Apply Settings Applies the display settings to the current real-time display.

Shortcut menu
Right-click the chromatogram to display the menu.

Reset Scaling Resets the X-axis and Y-axis ranges in the Chromatogram pane or 
the Spectrum pane to their default values. 

Table 11. Status mode parameters  (Sheet 2 of 2)

Parameters Description
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• If the currently acquiring sample is the last sample in the run, the run is marked 
Completed and sent to the Watson application.

2. To resume the acquisition for the next sample in the run, click Pause .

When you resume acquisition, the system begins with the next sample in the run. If you 
stopped the final sample in a run, the system begins the next run in the queue.

For detailed information about repeating the acquisition for a stopped sample, see 
Appendix B, “Restarting Runs.” 

To pause a run

You can pause a run in the Acquisition Queue and resume it later.

1. To pause the acquisition of the current run, click Pause .

After the current sample completes, the acquisition for the run pauses until you resume it.

The run status in the Run Manager view immediately changes to Paused, even if the 
current sample is still acquiring.

2. To resume the acquisition for the next sample in the run, click Pause .

To remove a currently acquiring run from the Acquisition Queue

You can remove an acquiring run from the Acquisition Queue and resubmit it later. 

For detailed information about restarting a run, see Appendix B, “Restarting Runs.” 

When you remove an acquiring run from the Acquisition Queue, the run returns to the 
Run Manager view and its status is Stopped. When you resubmit a stopped run from the 
Run Manager view, you can specify a range of sample numbers that you want to acquire. 
It is not necessary to reacquire previously acquired samples.

1. To remove a run from the Acquisition Queue, check the run check box and press the 
keyboard Delete key.

Watson application Acquisition QueueRun Manager view

Paused run

Resumed run

Watson AcquisitionRun Manager

Run removed
from queue

Stopped

Resubmitted run Resumes at 
specified sample
56 Watson TSQ Module User Guide Thermo Scientific



 5 TSQ Module: Acquiring Data
Monitoring the Run Status
• The currently acquiring sample immediately stops and the run is removed from the 
Acquisition Queue. 

• The status of the run in the Run Manager view is Stopped.

• When there are other runs in the Acquisition Queue, the pause button is red 
indicating that it is ready to start the next queued run.

2. To begin acquisition of the next run in the Acquisition Queue, click Pause . 

To remove a non-acquiring run from the Acquisition Queue

You can remove a run from the Acquisition Queue and resubmit it later. 

For detailed information about restarting runs, see Appendix B, “Restarting Runs.” 

When you remove an non-acquiring run from the Acquisition Queue, the run returns to 
the Run Manager view and its status returns to Pending. When you resubmit this run to 
the Acquisition Queue, it begins acquiring at the first sample.

1. To remove a non-acquiring run from the Acquisition Queue, check the run check box 
and press the keyboard Delete key.

The run is immediately removed from the Acquisition Queue and the run returns to the 
Run Manager view as Pending.

Note  To remove multiple runs from the Acquisition Queue, check the check box for 
each of the runs in the queue and press the keyboard Delete key. 

Watson application Acquisition QueueRun Manager view

Run removed
from queue

Pending

Resubmitted run Begins at 
sample 1
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To cancel a run in the Run Manager view

You can cancel a run in the Run Manager view. The TSQ Module application returns a 
canceled run to the Watson application and Watson users can resubmit the run to the 
TSQ Module application.

For detailed information about restarting runs, see Appendix B, “Restarting Runs.” 

1. Select the run in the Run Manager view.

You cannot use the Run Manager view to cancel a run that is currently in the Acquisition 
Queue (Submitted or Acquiring). 

2. Click Cancel Run.

The following confirmation message is displayed:

3. To return the run to the Watson application, click Yes.

Watson users can modify and resubmit the run or resubmit the run without changes.

Watson application Acquisition QueueRun Manager view

Canceled run
Audit trail

Resubmitted run Pending



6

Watson: Working with Processed Runs

This chapter provides information about working with runs in the Watson application that 
are in process or have already been processed by the TSQ Module application.

Reviewing Runs 
You can continuously monitor the status of runs, even while they are being processed in the 
TSQ Module application. You can configure the Watson application to require the review and 
acceptance of particular sample types. 

In the Watson application, you can review a run that is incomplete or ongoing. Use this 
feature to review a set of chromatograms while the LC/MS is acquiring additional samples. If 
a problem occurs in the run, you can see how far back in the sequence the problem occurred 
while the acquisition is taking place.

Use the following procedures:

• To review the list of runs

• To configure run review requirements

• To view the run queue in the Watson application

• To view an ongoing or incomplete run

• To view the run after data acquisition is complete

Contents

• Reviewing Runs

• Reintegrating Chromatograms

• Changing the Chromatogram Display

• Reviewing Internal Standards and Performing Regression
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Reviewing Runs
To review the list of runs

1. Choose Analytical > Analytical Run Actions. 

The Run Queue opens, listing recent runs. From this queue you can monitor the status of 
runs. You can also access the Run Review view that provides detailed information. 

2. To review a run, select it and click Run Review.

To configure run review requirements

1. Create or open a study in the Watson application.

2. Choose Study Actions > Configuration. 

The Configuration dialog box opens.

Figure 10. Configuration dialog box: Misc. 1 page

3. To require QCs, Unknowns, or STDs, select the appropriate parameter in the 
Chromatogram Run Review section.

4. To prevent users from reviewing a run before the run completes, select Prevent Run 
Review Prior to Completion in the Chromatogram Run Review section.
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Reviewing Runs
To view the run queue in the Watson application 

1. Open a study with an associated Peak Integration instrument.

2. Choose Analytical > Analytical Run Actions. 

The Run Queue opens. From this window, you can view the run status in real time. All 
runs are date and time stamped.

Figure 11. Run queue

Run Status Definitions

The following is a list of common run statuses when working with runs that are submitted to 
or processed by the TSQ Module application. For a complete list of run statuses, refer to the 
Watson User Manual.

• Submitted to TSQ Module: The run has been submitted to the TSQ Module application 
for processing.

• Completed: The run has been processed and is now complete.

• Created: The run has been created, but has not yet been submitted for processing.

• Canceled by: Notification that the run has been canceled and where the cancellation 
occurred.

• In Process: The run is currently being acquired. 

Run Status column
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6 Watson: Working with Processed Runs
Reviewing Runs
To view an ongoing or incomplete run

1. Select a run labeled as In Process.

2. Click Review.

Run results appear. 

Completed runs are labeled as such in the run queue. These runs are submitted to the 
TSQ Module application from the Watson application, processed in the TSQ Module 
application, and then sent back to the Watson application. 

To view the run after data acquisition is complete

1. Select a completed run and click Review.

Run results appear. 

2. To navigate between sample analytes, click the tabs at the top of the view.

Figure 12. Sample analytes

Sample analytes
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Reintegrating Chromatograms
Reintegrating Chromatograms
This section provides instructions for reintegrating chromatograms.

Reintegrate chromatograms by doing one of the following:

• Changing the peak processing parameters

–Or–

• Moving the baseline

Use the following procedures:

• To change the processing parameters

• To configure identification parameters

• To configure the ICIS integration parameters

• To configure the ICIS advanced parameters
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6 Watson: Working with Processed Runs
Reintegrating Chromatograms
To change the processing parameters

1. Select a row in the top part of the window. 

2. Right-click and choose Reintegrate > Analyte or Int. Std. from the menu.

The Reintegrate Chromatogram view opens with the Identification page displayed.

Figure 13. Reintegrate Chromatogram view – Identification page

To configure identification parameters

1. Click the Identification tab.

2. Type values in the following fields in the top-right view:

• Smoothing points: Enter an odd-numbered value between 1 and 5.

• Min. Peak Height (S/N): Enter a value between 0.00 and 999.00.

• Retention Time: Enter a value between 0.00 and 999.00.

• Expected (min)
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Reintegrating Chromatograms
• Window (sec)

• View Width (min)

3. Click Update Chromatogram to save your changes. 

The Chromatogram on the right side is updated, so you can compare it with the original. 
Thermo Scientific Watson TSQ Module User Guide 65
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Reintegrating Chromatograms
To configure the ICIS integration parameters 

1. Click the ICIS Integration tab.

2. Complete the following fields in the top-right pane:

• Baseline Window: The number of scans over which to look for a local minima 
(1 to 500, Units 1).

• Area Noise Factor: Noise level multiplier used to determine the potential peak signal 
threshold (1–1000, Units 1).

• Constrain Peak Width: Selecting this check box constrains peak width.

• Peak Height (%): Constrain peak edges to a percentage of Peak Apex Height (0.00 to 
100.0).

• Tailing Factor: Constrain peak edges to a ratio of the trailing and leading edges (0.5 
to 9.0).

3. Click Update Chromatogram to save your changes. 

The Chromatogram on the right side is updated, so you can compare it with the original.

Figure 14. Reintegrate Chromatogram view – ICIS Integration page
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Reintegrating Chromatograms
To configure the ICIS advanced parameters

1. Click the ICIS Advanced tab.

2. Complete the following fields in the top-right pane:

• Noise Method: Select Incos Noise or Repetitive Noise.

• RMS: Click to activate.

• Min. Peak Width: Minimum number of scans in a peak (0 to 100, units 1).

• Multiplet Resolution: Minimum separation in scans between two peaks (0 to 500, 
units 1).

• Area Tail Extension: Number of scans past endpoint to use in averaging intensity (0 
to 100, units 1).

• Area Scan Window: Number of scans to either side of the apex allowed in a peak. Use 
0 to include all (0 to 100, units 1).

3. Click Update Chromatogram to save your changes.

4. When you have made all parameter changes, apply them to the selected sample (Apply) 
or apply to each sample in the run (Apply All). 

The new parameters are stored in the database. 

Figure 15. Reintegrate Chromatogram view – ICIS Advanced page 
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6 Watson: Working with Processed Runs
Changing the Chromatogram Display
Changing the Chromatogram Display
In the chromatogram view, you can change the display.

Use the following procedures:

• To move the baseline

• To view a chromatogram in the gallery

• To zoom in on a chromatogram

To move the baseline

Using the cursor, drag the baseline in the chromatogram view.

Figure 16. Moving the baseline

To view a chromatogram in the gallery

1. From the Run Review view, select an analyte.

2. Right-click and choose View in Gallery from the menu. 

3. Select one of the following: Analyte Only, Analyte & Int. Std., or Int. Std. Only.
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Changing the Chromatogram Display
Figure 17. Gallery view (analyte only)

4. Click Exit to close the gallery window.

To zoom in on a chromatogram

1. Select a sample. 

2. Zoom in on the corresponding chromatogram by dragging the cursor.

3. To reset the chromatogram, right-click and choose Reset Scaling. 

Additional Run Review Features

In addition to using the display features of the Run Review view, you can do the following:

• Show All Injections

• Accept a Run

• Resubmit a Run to a Different Instrument

Show All Injections 

When the Show All Injections check box is selected, all injection values that exist for all run 
samples are displayed. 

When the Show All Injections check box is cleared, only the last injection values for the 
samples in the run are displayed. This has an impact on the Run Review view. 
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Changing the Chromatogram Display
Accept a Run

Using the Watson application, you can review analytes, IS mass chromatograms, and peak 
detection results, and reintegrate the results before accepting the run. To accept a run, click 
Accept Review on the Run Review view.

Resubmit a Run to a Different Instrument

You can cancel a run that has been submitted to the TSQ Module application and resubmit it 
to an alternate instrument stack or an alternate instrument, only if no data has already been 
acquired. 
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Reviewing Internal Standards and Performing Regression
Reviewing Internal Standards and Performing Regression
Use the following procedures:

• To review internal standards

• To filter sample types from the run results

• To flag a sample or sample-analyte with a Reassay tag

• To flag a sample or sample-analyte with a text comment

• To deactivate or reactivate a sample-analyte for regression

• To save to the database

• To perform a standard regression

To review internal standards

• From the Run Review view, click Internal Standards Review. 

The Raw Data Analysis view opens with the Chart page displayed.

Figure 18. Raw Data Analysis view – Chart page 
\

Thermo Scientific Watson TSQ Module User Guide 71



6 Watson: Working with Processed Runs
Reviewing Internal Standards and Performing Regression
The Chart page contains the following areas:

• Analysis type 
– Raw Data Analysis
– Mean

• Sample Information
– Run Sample Sequence Number
– % Difference
– Sample Type
– Watson sample ID

• Zoom options: Click to allow zooming.

• Y-Axis scaling: Set the Y-axis scaling.
– To update, edit the Min Y and Max Y fields and click Update Y Axis.
– To restore defaults, click Restore Defaults.

• Calculation of Internal Standards Limits: Determine the criteria for calculating internal 
standards.

• Sample types to be used for mean: Select the option next to the sample type to select All 
Active Samples, STDs only, STDs and QCs only.

• Calculation Method 
– Use Mean +/- offset: Select and enter the lower limit of percentage of mean and upper 

limit of percentage of mean.
– Use Mean +/- SD: Click the Number of SDs field and type a number.
– Use Range +/- offset: Select and enter the lower limit of percentage of mean and 

upper limit of percentage of mean.
– Click Update Limits to update the limits.

• Print: Print the raw data analysis.

• Save: Save the raw data analysis.

• Exit: Exit the page.

Figure 19. Raw Data Analysis view - Grid page
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Reviewing Internal Standards and Performing Regression
To filter sample types from the run results

1. Open a study with an associated Peak Integration instrument.

2. Choose Analytical > Analytical Run Actions. 

3. From the run results, select a run that contains results and click Review. 

Al results are shown in the initial view. You can select one sample-analyte at a time from 
the list of samples in a run, and display chromatograms and information about that 
analyte's peak and its associated internal standard peak. 

When this view loads, it defaults to All samples.

Figure 20. Run Results – All Samples

4. (Optional) Filter this view by Standards, QCs, Blanks, and Unknowns. 

Figure 21. Standards Filtering tabs

5. If you want to accept the review, click Accept Review.
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Reviewing Internal Standards and Performing Regression
To flag a sample or sample-analyte with a Reassay tag

1. From the run results, right-click the sample or sample-analyte and choose Tag for 
Reassay from the menu.

2. Do one of the following:

• To save the tag, click Save. 

–Or–

• To exit without saving any changes, click Exit.

To flag a sample or sample-analyte with a text comment

1. From the run results, right-click the sample or sample-analyte and choose Apply/Edit 
comment from the menu.

The Sample Comment dialog box opens.

2. Enter a comment or choose one from the list.

3. Click OK.

To deactivate or reactivate a sample-analyte for regression

1. Right-click the sample-analyte and choose either Activate to activate the sample analyte, 
or Deactivate to deactivate it.

2. Do one of the following:

• To save the change, click Save. 

–Or–

• To exit without saving any changes, click Exit.

To save to the database

Click Save on the Run Review view.
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To perform a standard regression

1. Choose Analytical > Standard Regression. 

The Standard Regression dialog box opens with two grids: The top grid contains a list of 
each Analytical Run for which Raw Data has been imported. The lower grid is a list of 
analytes associated with the specified Analytical Run with analyte status, regression data, 
LLQ, ULQ, and who performed the regression.

2. Click Regression. 

The Watson application performs a standard regression on the specified analyte associated 
with the specified Analytical Run. 

3. After regression is complete, click the appropriate button to accept, reject, or save the 
results.

For more information, refer to the Analytical Menu chapter in the Watson User Manual.
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7

Watson: Reports and Printing Capabilities

Use the Watson application to generate several types of reports, including integration reports 
at the study and sample levels, audit reports, and several Crystal reports. You can then print 
reports using extended printing capabilities available within the Watson application. 

Study-level and Sample-level Integration Reports
This section provides information about study-level and sample-level integration reports.

To view study-level and sample-level reports 

1. Access the Run Review view. 

2. From the Select Report Type list, select either Study-Level Integration Report or 
Sample-Level Integration Report. 

See “Study-Level Integration report” on page 78 or “Sample-Level Integration report” on 
page 79.

You can subdivide each report into Master Report, ICIS Report, or Reinjection Report by 
selecting the appropriate options on the top of the view.

The reports show the integrated peak as a shaded area and its raw areas/height. It displays 
a descriptive header/footer that contains the following information:

• Design info (Subject, Treatment, Group, Nominal Day, Nominal Hour, Nominal 
Minute, Split #), Watson Sample ID, Watson Custom ID 

• Mass data (Q1 m/z, Q3 m/z)

• Method and Tune information

Contents

• Study-level and Sample-level Integration Reports

• Audit Reports

• Printing Capabilities
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7 Watson: Reports and Printing Capabilities
Study-level and Sample-level Integration Reports
• Chromatogram data (for example, peak area, peak height, retention time, acquisition 
date/time in currently supported Watson date and time formats, acquisition 
instrument info)

• Watson information (for example, Study, Run #, Position in run, plate position, 
injection volume) 

• Edit info (for example, date/time and person last edited for reintegrations)

• Multi-Level Approval or eSig info of analytical run and individual chromatograms

Figure 22. Study-Level Integration report
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Study-level and Sample-level Integration Reports
Figure 23. Sample-Level Integration report
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Audit Reports
Audit Reports
Use the Watson application to create, view, and print system- or study-level audit reports for 
the TSQ Module application. You can print a basic audit report from the Watson File menu 
that contains TSQ Module-specific information alone, or in combination with all other 
categories. In addition, you can view and print detailed audit reports from the Create 
Sequence File, Import Results, and View Analytical Run views.

• Generating a Watson Audit Report

• Generating a TSQ Module Status/Audit Report

Generating a Watson Audit Report

This process is similar to existing Watson application workflows, with the exception of 
selecting TSQ Module as the category of information to be viewed. 

To view audit reports for TSQ Module data

1. Choose File > Audit Report. 

The Select Criteria for Audit Report view opens. See “Select Criteria for Audit Report 
view” on page 81.

2. From this view, enter or select the following criteria:

• Date/Time and Audit Level

• Date and time range

• System or Study Audit Level (your level of access is established by the system 
administrator)

• Category:

– For TSQ Module information only, select TSQ Module.

– For all information, select All Categories.

• User: Select the user or role.

• Project-Study: Select at least one study from the list that appears in this column.

3. After entering and selecting the report criteria, do one of the following:

• Click OK to generate the audit report. See “Audit Report” on page 82.

–Or–

• Click Exit to close the view without generating the report.

For more information, refer to the File Menu chapter in the Watson User Manual.
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Audit Reports
Figure 24. Select Criteria for Audit Report view
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Audit Reports
Figure 25. Audit Report
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Audit Reports
Generating a TSQ Module Status/Audit Report

This Status/Audit report provides you with more detailed information about the samples in a 
run. To generate this report, follow standard Watson application processing as outlined in this 
section. Note that in the example below, TSQ Module-specific data is shown. The Runs are 
labeled as “reinjection,” and the instrument type is Peak Integration. 

To generate a TSQ Module status or audit report

1. Create or open a TSQ Module study.

2. Choose Analytical > Analytical Run Actions. 

The Create Sequence File, Import Results, and View Analytical Run view opens.

Figure 26. Create Sequence File, Import Results, and View Analytical Run view

3. Select a run and click Status/Audit Report. 

The Watson application generates the Status/Audit Report.

Figure 27. Status/Audit Report
 

For more information, refer to the Analytical Menu chapter in the Watson User Manual.
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Printing Capabilities
Printing Capabilities
Printing capabilities in Watson include:

• Printing chromatograms or saving them to a fully locked PDF or open PDF file.

• The on-screen display and the printed version of text, numerical values, and graphics 
(chromatograms and charts/graphs) are identical. 

Printing a Chromatogram

To print a chromatogram

1. Click the Print icon.

The Print dialog box opens. 

2. Select the check boxes to print Analyte Chromatogram, Internal Standard 
Chromatogram, or Result Data.

3. Click OK. 

The Preview window shows the selected analyte chromatogram. Information, such as 
peak area/height, retention time, Q1 and Q3 mass, and analyte name, is displayed.

4. Click Print to print the chromatogram.

5. Save the chromatogram to a PDF file by clicking the Export Document icon (document 
with diskette).

You can print the chromatogram, save it to a PDF file, or both. What you see is identical 
to what is printed.

6. Close the Preview window.

Another Preview window is displayed. The window displays the internal standard 
chromatogram. Information, such as peak area/height, retention time, Q1 and Q3 mass, 
and IS name, is displayed.

7. Click Print to print the chromatogram.

8. Save the chromatogram to a PDF file by clicking the Export Document icon. 

You can print the chromatogram, save it to a PDF file, or both.

9. Close the Preview window.

A new Preview window opens. This window displays results data, which you can print. 
The print display and printout are identical.

10. Close the Preview window for the results data.
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Printing Capabilities
Printing Capabilities

The Watson application lets you preview reports before printing or modify page layout, 
orientation, or paper dimensions. 

When viewing a report, a print menu appears at the top of the window. The print menu lets 
you navigate between pages of the report, locate text, zoom, and print.
. 

Figure 28. Print menu

Table 12. Print menu icons

Icon Description

Export report

Print report

Refresh

Toggle group tree

Go to first page

Go to previous page

Go to next page

Go to last page

Go to page

Close current view
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Printing Capabilities
Find in page

Zoom

Table 12. Print menu icons

Icon Description
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A

TSQ Module: Menu and Toolbar Reference

This appendix provides a reference to the Watson TSQ Module menus, icon bars, and status 
bars.

Contents

• Using the Menu

• TSQ Application Menu Commands

• Title Bar and Ribbon Commands

• Status Bar

• Select Mode

• Setup Mode

• Acquire Mode

• Status Mode

• Manage Mode
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A TSQ Module: Menu and Toolbar Reference
Using the Menu
Using the Menu
The application menu in the upper left corner of the TSQ Module window includes 
commands to open the Select mode, save changes to a run, log out of or exit the application, 
or display Help.

To use the keyboard to activate a menu command

1. Click the application icon  to display the TSQ Module application main menu.

2. Type the first character of the command in the menu title, such as S in Select. 

If you do not choose a command, you can close the menu by pressing the ESC key.

TSQ Application Menu Commands
The application menu in the upper left corner of the TSQ Module application window 
includes commands to open the Select mode, save changes to a run, log out of or exit the 
application, or display Help.

Click the application icon  in the ribbon to display the TSQ Module application main 
menu.

Menu command Description

Select Displays the Select mode.

Save Saves changes to a run (Position, Injection Volume, or 
Comment).

Logout Closes the TSQ Module application and presents a new 
Login screen. This does not stop the acquisition of runs.

Help

Watson TSQ Module Help Opens the main Help tool.

How to Use Help Opens instructions in the Help for using the online 
navigation features.

Glossary Opens the glossary in the Help tool.

About Watson TSQ Module Opens an about box that displays the version of the tool 
you are running, copyright information, and the end 
user agreement.

Exit Closes the TSQ Module application. This does not stop 
the acquisition of runs.
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Title Bar and Ribbon Commands
Title Bar and Ribbon Commands
The title bar of the window includes icons to minimize, maximize, or close the TSQ Module 
application. 

The ribbon of the window includes icons to access the Help or log out of the TSQ Module 
application.

Status Bar
At the bottom of the TSQ Module application window is a status bar that reports the name of 
the run that is currently acquiring (or reports Ready if no run is acquiring) and the number of 
runs that have the status Pending, Submitted, or Stopped.

Command Description

Collapses the TSQ Module application window to your toolbar.

Maximizes or minimizes the size of the application window.

Closes the TSQ Module application. This does not stop the 
acquisition of runs.

Closes the TSQ Module application and presents a new Login 
screen. This does not stop the acquisition of runs.

Opens the Help.

Title bar

Ribbon
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Accessing TSQ Module Modes
Accessing TSQ Module Modes 
The TSQ Module application uses five functional modes: Select, Setup, Acquire, Status, and 
Manage. Access the Select mode from the TSQ Module application menu – see “TSQ 
Application Menu Commands” on page 88. Access the other modes from the navigation 
pane.

Mode Description

Select The Select mode is the first mode you see when you log in to the TSQ 
Module application. In the Select mode, you can select a run for 
acquisition.

Setup From the Setup mode, you can edit the Position, Injection Volume, or 
Comment values for a sample.

Acquire From the Acquire mode, you can specify acquisition settings and start 
the acquisition of a run. 

Status From the Status mode, you can start, stop, or pause an acquisition, 
monitor the run manager and instrument status, monitor the 
Acquisition Queue, or control the real-time display.

Manage From the Manage mode, you can monitor the status of the runs, cancel a 
run and return it to the Watson application, or select a run for 
acquisition.
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Select Mode
Select Mode
The Select mode is the first mode you see when you log in to the TSQ Module application. 
The Run Select view displays all the runs assigned to you for the current database. In the Run 
Select view, you can select a run for acquisition.

Table 13. Run Select view parameters  (Sheet 1 of 2)

Parameter Description

Column Selector Opens the Column Selector where you can add or remove columns 
from the grid display. Column choices are immediately 
implemented in your grid display, but the column choices are not 
saved when you exit the TSQ Module application.

Stopped/Submitted/
Pending

Status indicators at the bottom of the window report the number of 
runs for each type of status.
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Select Mode
Columns

Status Status of each run: Pending, Submitted, Acquiring, Paused, 
Stopped. or Completed.

• Pending - The run arrived from the Watson application and 
awaits acquisition. This run could have been submitted to the 
Acquisition Queue and returned to the Run Manager view 
before it began acquiring.

• Submitted - The run is assigned for acquisition but is not 
currently acquiring. The run is in the Acquisition Queue.

• Acquiring - The run has progressed to the top of the Acquisition 
Queue and is currently acquiring. 

• Paused - The run is assigned to an instrument and is currently 
acquiring, but has been paused and waits between samples.

• Stopped - The run was assigned to an instrument and was 
acquiring, but was removed from the Acquisition Queue.

• Completed - The acquisition has finished running and the run 
data was returned to the Watson application. 

Completed runs might not always be observed in the Run 
Manager view. When the TSQ Module application finishes 
sending the results of the last completed sample to the Watson 
application, it marks the run as Completed and quickly removes 
the run from the Run Manager view.

Run Name A combination of the project, study, and run ID as defined in the 
Watson application.

Assay Date Date when assay method was created.

Receive Date Timestamp when run was received.

Table 13. Run Select view parameters  (Sheet 2 of 2)

Parameter Description
92 Watson TSQ Module User Guide Thermo Scientific



 A TSQ Module: Menu and Toolbar Reference
Setup Mode
Setup Mode
From the Setup mode, you can edit the parameters of a run in the TSQ Module application. 
Every action you take in the Run Edit view in the Setup mode is authenticated and an audit 
trail is sent to the Watson application.

Table 14. Setup mode parameters

Parameter Description

Save Run Saves the edits you made to the run. The Save Run command can be 
specified to require an electronic signature. See “Using E-Signatures” 
on page 25.

Columns

Sample Type Defines how the Watson application processes the sample data. Each 
sample must be classified as one of the following sample types: 

• Unknown
• Blank
• QC (quality control)
• Standard

Sample ID An alphanumeric string of characters that can be used to uniquely 
identify the sample.

Level The level defined for a calibration sample or quality control sample. 

Position Sample position number in the autosampler, usually provided by the 
Watson application. This column value is editable.

Injection Volume 
(μL)

Microliters to be injected. 
• When you have an autosampler configured, the injection 

volume is validated against the allowable range specified by the 
autosampler.

• When you do not have an autosampler configured, you can 
enter a range of 0.1-1000.

This column value is editable.

Comment Optional information about the sample. This column value is 
editable.
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Acquire Mode
Acquire Mode 
From the Acquire mode, you can specify acquisition settings and start the acquisition of a run. 

Table 15. Acquire mode parameters  (Sheet 1 of 3)

Command Description

Acquire samples Displays the first and last samples to acquire. Available only for a 
previously Stopped run.

Priority Run Inserts this run into the Acquisition Queue ahead of all submitted, 
non-acquiring runs.

Additional comment A comment that is returned to the Watson application in the run 
report.

Instrument Method

Startup Method Specifies that the TSQ Module application runs the startup 
method specified in the run data before the run starts. No data is 
acquired by this method, and no autosampler injection takes place. 
This feature is not available for all devices.

Shutdown Method Specifies that the TSQ Module application runs the shutdown 
method specified in the run data after the run has completed. No 
data is acquired by this method, and no autosampler injection 
takes place. This feature is not available for all devices.
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System power scheme

On Keeps the system in the On state when the current run is 
completed. When On is selected, you can begin another run 
without waiting. All power and flows are maintained at 
operational levels. Default: On

Standby Keeps the system in the Standby state when the current run is 
completed. When you select Standby, you can begin another run 
with only a short delay between runs. 

Some devices do not have a Standby feature. For devices with this 
feature, a power-saving or consumable-saving mode is entered and 
the devices can be switched back on in approximately 15 minutes 
or less. Depending the instrument, this state turns gas and liquid 
flows to Off, but maintains heaters and other subsystems in an On 
state so that there is no warm-up time required when you change 
from Standby to On. 

Off Keeps the system in the Off state when the current run is 
completed. The Off state indicates that all power to the 
instrument, which can be controlled by the TSQ Module 
application, is turned Off. This includes power to all heaters and 
most subassemblies, but in some cases not all subassemblies. 

Some devices do not have an Off feature. For devices that do have 
this feature, a power-saving or consumable-saving mode is entered 
and you can manually switch the devices back on. 

When several runs are queued, the system power scheme of the last 
submitted run is used. 

Caution The Off state does not guarantee that all voltages are 
turned off nor does it indicate that all heated components are at 
room temperature. To perform maintenance on an instrument, 
refer to the hardware manual for your instrument. 

Function buttons

Run Starts the acquisition for the currently selected run and opens the 
Status view.

Table 15. Acquire mode parameters  (Sheet 2 of 3)

Command Description
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Columns
(Column values are not editable in the Acquire mode.)

Sample Type Defines how the Watson application processes the sample data. 
Each sample must be classified as one of the following sample 
types: 

• Unknown
• Blank
• QC (quality control)
• Standard

Sample ID An alphanumeric string of characters that can be used to uniquely 
identify the sample.

Level The level defined for a calibration sample or quality control 
sample. 

Position Sample position number in the autosampler, usually provided by 
the Watson application.

Injection Volume Microliters to be injected. 
• When you have an autosampler configured, the injection 

volume is validated against the allowable range specified by the 
autosampler.

• When you do not have an autosampler configured, you can 
enter a range of 0.1-1000.

Comment Optional information about the sample.

Table 15. Acquire mode parameters  (Sheet 3 of 3)

Command Description
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Status Mode
From the Status mode, you can start, stop, or pause an acquisition, monitor the run manager 
and instrument status, monitor the Acquisition Queue, or control the real-time display.

Table 16. Status mode parameters  (Sheet 1 of 2)

Parameter Description

Method-defined traces Displays real-time chromatograms corresponding to the 
components defined in the processing method. When the 
component traces are turned off, the total ion current (TIC) trace 
is displayed.

Show spectrum trace Displays the mass spectrum in the spectrum pane. 

Continuous update Continuously updates the spectrum trace to show the most current 
scan.

Manual select Display the spectrum trace of the currently selected peak.

User-defined RT range Displays chromatograms with a time range between the times 
specified in the Min RT and Max RT boxes.
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Min The start time of the chromatogram traces. 

Note The Min box becomes active only when you select 
User-defined RT range. 

Max The end time of the chromatogram traces. 

Note The Max box becomes active only when you select 
User-defined RT range. 

Apply Settings Applies the display settings to the current real-time display.

Starts an acquisition or resume an acquisition that has been 
paused.

Pauses an acquisition after the current sample has been completely 
acquired.

Immediately stops the current acquisition. Acquisition for the 
current sample stops and the sample is considered complete. The 
acquisition for the run is paused.

Pauses the real-time display during an acquisition.

Displays the Spectrum pane below the Chromatogram pane.

Stopped/Submitted
/Pending

Status indicators at the bottom of the window report the number 
of runs for each type of status.

Shortcut menu
Right-click the chromatogram to display the menu.

Reset Scaling Resets the X-axis and Y-axis ranges in the Chromatogram pane or 
the Spectrum pane to their default values. 

Stopped/Submitted
/Pending

Status indicators at the bottom of the window report the number 
of runs for each type of status.

Table 16. Status mode parameters  (Sheet 2 of 2)

Parameter Description
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Manage Mode
From the Manage mode, you can monitor the status of the runs, cancel a run and return it to 
the Watson application, or select a run for acquisition.

Table 17. Manage mode parameters  (Sheet 1 of 2)

Command Description

Function buttons

Select Run Opens the Setup view for the highlighted run.

Cancel Run Removes the highlighted run from the list and returns the run to 
the Watson application.

Columns

Status Status of each run: Pending, Submitted, Acquiring, Paused, 
Stopped. or Completed.

• Pending - The run arrived from the Watson application and is 
assigned to the instrument at this workstation.

• Submitted - A TSQ Module application user has submitted 
this run to the Acquisition Queue but is not currently 
acquiring.

• Acquiring - The run has progressed to the top of the 
Acquisition Queue and is currently acquiring. 

• Paused - The run has been assigned to an instrument and is 
currently acquiring, but has been paused and is waiting 
between samples.

• Stopped - The run has been assigned to an instrument and 
was acquiring, but was removed from the Acquisition Queue.

• Completed - The run has completed acquisition.

Completed runs might not always be observed in the Run 
Manager view. When the TSQ Module application finishes 
sending the results of the last completed sample to the Watson 
application, it marks the run as Completed and quickly 
removes the run from the Run Manager view.
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Database The the Watson application database or the friendly name assigned 
in the Environments.xml file.

Run Name A combination of the project, study, and run ID as defined in the 
Watson application.

Samples Number of samples in the run.

Receive Date Timestamp when run was received.

Assay Date Date when assay method was created.

Description Watson user comments.

Extraction Date Date when samples in the run were extracted.

Analyst The user who created the run in the Watson application.

Observations The Watson application user comments.

Table 17. Manage mode parameters  (Sheet 2 of 2)

Command Description
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Restarting Runs

This appendix describes the process of restarting the acquisition of a run after it has been 
stopped.

For several reasons, a user might remove a run from the TSQ Module application before it 
completes acquisition and return it to the Run Manager view or to the Watson application. A 
run can be restarted within the TSQ Module application or returned to the Watson 
application.

From the Watson application, you can modify a run that has been returned from the TSQ 
Module application and send the run back for re-injection. When a run is returned for 
re-injection from the Watson application, the TSQ Module application treats it like any other 
run. 

Restarting a Run from within the TSQ Module Application
For many reasons, you might want to remove a run from the Acquisition Queue and later 
restart the run from the Run Manager view.

This section describes the following:

• Restarting a Stopped Run at the Beginning

• Restarting a Stopped Run at a Specific Sample

• Restarting a Run from the Run Manager View: Workflow

Contents

• Restarting a Run from within the TSQ Module Application

• Returning a Run to the Watson Application

• Re-injecting a Run from the Watson Application
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Restarting a Stopped Run at the Beginning

For many reasons, you might want to stop a submitted or acquiring run:

• To correct a minor problem with the instrument

• To fix a leak, replace a worn-out column, or correct any other minor maintenance task

You can send the run from the Acquisition Queue back to the Run Manager view, perform 
some offline injections, and resubmit the run to the Acquisition Queue. 

Example scenario

1. You initially pause the run, and then decide that the problem is more serious than 
anticipated.

2. You remove the run, sending it back to the Run Manager view. 

3. After correcting the problem, you might perform system suitability runs in the Xcalibur 
or LCquan applications to confirm that the system is working.

4. Finally, you resubmit the run for acquisition.

For detailed information about pausing and stopping a run, see “Pausing/Stopping/Canceling 
Runs” on page 55. 

For detailed information about resubmitting a run, see “Acquiring a Run” on page 45.

Restarting a Stopped Run at a Specific Sample

For many reasons, you might want to stop a submitted or acquiring run:

• You see a flat line on the real-time plot where you expect to see a signal and realize that 
recent acquisitions in the run are not useful.

• You see a physical problem with the instrument and want to fix it and then restart the 
run.

You can send the run from the Acquisition Queue back to the Run Manager view and 
resubmit it to the Acquisition Queue. When you return the run to the Acquisition Queue, 
you can start the acquisition from any row to reacquire samples whose acquisitions were 
flawed.

Example scenario

1. You initially pause the run, and then decide that the problem is more serious than 
anticipated.

2. You remove the run, sending it back to the Run Manager view. 
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3. After correcting the problem, you perform system suitability runs in the Xcalibur 
application.

4. Finally, you resubmit the run for acquisition, starting from a previous sample to ensure 
that all bad samples are restarted.

For detailed information about pausing and stopping a run, see “Pausing/Stopping/Canceling 
Runs” on page 55.

For detailed information about submitting a run, see “Acquiring a Run” on page 45.

Restarting a Run from the Run Manager View: Workflow

Select
(Run Select view)

Manage
(Run Manager view)

Setup
(Run Edit view)

Acquire
(Run Edit view)

Status
(Run Status view)

Run request 
from Watson

Acquired data
to Watson

Removed run

Canceled run
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Returning a Run to the Watson Application
For many reasons, you might want to stop a submitted or acquiring run and send it back to 
the Watson application:

• You want to rebalance the workload to another instrument, so you want to send all 
pending runs back to the Watson application.

• The local instrument requires maintenance and you want to move all runs to another 
instrument.

• The local instrument has the wrong column or other mismatch (other than the device 
stack) that was discovered after the run was submitted, so you want to send all pending 
and acquiring runs back to the Watson application.

You can send the run from the Acquisition Queue back to the Run Manager view and then 
back to the Watson application. A Watson user can then reassign the run to a different 
instrument and resubmit it to another the TSQ Module application.

Example scenario

1. You initially pause the run, and then decide that the problem is more serious than 
anticipated.

2. You remove the run, sending it back to the Run Manager view. 

3. You discover that the problem with the instrument is serious enough that the run cannot 
be restarted.

4. Finally, you cancel the run in the Run Manager view, sending the run back to the Watson 
application.

For detailed information about pausing, stopping, and canceling a run, see 
“Pausing/Stopping/Canceling Runs” on page 55.
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Returning a Run to the Watson Application: Workflow

Select
(Run Select view)

Manage
(Run Manager view)

Setup
(Run Edit view)

Acquire
(Run Edit view)

Status
(Run Status view)

Run request 
from Watson

Acquired data
to Watson

Removed run

Canceled run
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Re-injecting a Run from the Watson Application
In the Watson application, you can select one or more samples within the same run to 
re-inject. The ability to do this is limited to a specified time frame. Samples that are selected 
to be re-injected are submitted to the TSQ Module application, where they are processed and 
submitted back to the Watson application to be reviewed and accepted as part of the run 
review. After a run is accepted, samples can no longer be re-injected.

Selecting Samples to Re-inject

The Watson application and the TSQ Module application process re-injected samples in 
groups. When selecting samples to re-inject, you can select some samples but not others until 
the first set is in the queue. 

To select samples to re-inject

1. Access the run queue. 

2. Choose Analytical > Analytical Run Actions.

3. Select a completed run and click Review.

The Run Review form opens. 

4. Click a sample to select it.

Figure 29. Right-mouse menu

5. Right-click and choose Reinject Sample from the menu. 

The sample is marked as Pending in the Injection column. This step can be repeated for 
additional samples.

6. Click Save to submit the sample to the TSQ Module application for processing. 

7. Click Exit to close the form.

The Run Status in the Run Review view is Submitted to TSQ Module.
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Canceling Re-injected Acquisitions

To cancel a re-injected acquisition

1. Click a sample to select it.

2. Right-click and choose Cancel Re-injection from the menu.

This prevents the sample from being transmitted to the TSQ Module application.

To review and accept re-acquired chromatograms

The Watson application enforces the acceptance of QCs, Unknowns, or STDs, or 
prevents run review prior to completion, as was specified in the Configuration form. 

1. Access the Run Review form.

2. Click on the tabs to view All samples, Standards, Blanks, QCs or Unknowns. 

3. Click Accept Review to accept.

You receive the following message: 

This will save any changes made and accept all chromatograms for this 
run. It will also prevent any future reintegrations and re-injections.

4. Click OK.

Accepting the Analyte Results from the Standard Regression Form

Analyte results can be accepted from the Standard Regression form. 

To accept analyte results from the Standard Regression form

1. Access the Standard Regression form by selecting Analytical > Standard Regression.

The Standard Regression form opens. 

2. Click the run to select it.

3. Click Regression. 

If the Run Review has not yet been marked as accepted, an alert appears. 

4. Click OK. 

The Standard Regression form opens with the Standard and QC tab displaying.

5. To accept or reject the results of the analyte, select an analyte and then click Accept or 
Reject. 

6. Click Cancel to close the form.
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Quantitative Analysis Overview

This appendix describes some of the basic principles and terminology of quantitative 
analysis1and contains the following topics:

About Quantitative Analysis
In some applications, such as a clinical trial, you might be seeking the maximum possible 
accuracy from your measurements. Time and cost of analysis are less important than achieving 
the highest possible standards in precision and accuracy. This process of measuring the 
amount of a particular component in a sample is called quantitative analysis. 

In other applications, such as in trace analysis, you might only want to estimate the quantity of 
a component. It might be sufficient to know that the component is present at a level either 
significantly higher or significantly lower than a defined threshold. For example, knowing 
whether a patient has overdosed 15 or 20 times above a prescribed limit is generally not as 
important as simply knowing that the limit has been exceeded. Such cases would require a 
rapid measurement rather than a precise one. This form of measurement is generally called 
semi-quantitative analysis.

Quantitative analysis consists of the following steps:

• Preparing samples 

• Developing a suitable chromatographic method

• Calibrating the mass spectrometer’s response

1 For further information about the principles of quantitative analysis, refer to Mass Spectrometry: Principles and 
Applications; de Hoffman, E., Charette, J., Stroobant, V.; Wiley: New York, 1996; and Introduction to Mass 
Spectrometry, 3rd ed.; Watson, J.T., Lippincott-Raven: Philadelphia, PA, 1997.

Contents

• About Quantitative Analysis

• Considering the Variables of Quantitative Analysis by LC/MS/MS

• Quantitative Analysis Techniques

• Sample Types
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• Analyzing the samples

• Reviewing the results

This documentation does not describe sample preparation and chromatographic method 
development. This documentation assumes that you have met these important prerequisites 
to achieving high quality quantitative analysis. For guidance in these areas, refer to the 
documentation for your autosampler, LC pump or MS pump, and mass spectrometer. 

Considering the Variables of Quantitative Analysis by LC/MS/MS
The combination of liquid chromatography (LC) and mass spectroscopy (MS) sets up a 
unique set of considerations. If you are familiar with quantitative analysis using one or the 
other of these analytical tools, the information in the following topics will prove useful:

• Using LC for Analyte Separation

• Using MS/MS for Analyte Detection

Using LC for Analyte Separation

When working with LC systems, you become accustomed to developing methods for analytes 
of interest. These methods take into account a variety of parameters. Consider the following 
LC parameters for optimum separation of compounds: 

• Composition of stationary phase

• Column diameter

• Column length

• Column usability over time

• Solvent(s) or composition of mobile phase 

• Flow rates

• Isocratic or gradient (ramped) solvent compositions

Often the only measurable result of optical detectors that you can use to identify an analyte is 
the retention time at a specified wavelength. To quantitate compounds accurately, the 
compound peaks must be distinctly separated from each other in time. By carefully 
optimizing the LC variables listed above, you can successfully separate and detect compounds 
with an optical detector such as an ultraviolet (UV) or photodiode array (PDA) detector.
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In contrast to optical detectors, mass spectrometers can often successfully detect individual 
analytes even when two or more compounds coelute as a single chromatographic peak. 
Coeluting compounds are ionized in the mass spectrometer, and the parent or fragment ions 
specific to the analyte or analytes are detected and measured for quantitative analysis. Because 
the mass spectrometer detection is so specific, you can reduce the chromatographic resolution 
and shorten the run times.

Using MS/MS for Analyte Detection

To optimize detection of ions by MS/MS, consider the following variables when working with 
a mass spectrometer interfaced to an LC:

• Solution chemistry and polarity of the analyte of interest

• Probe selection (H-ESI, ESI, APPI, or APCI)

• Collision energy to fragment parent ions inside the mass spectrometer (optimized by 
experiment)

The LC provides a stream of analyte solution (eluate) into the mass spectrometer where the 
analyte is detected. You must consider the content of modifiers, salts, and contaminants in the 
eluate. Specifically, you must ensure that what goes into the inlet of the mass spectrometer 
does not suppress ionization of the compound of interest. Salt concentrations above 10 mM 
and strong acids and bases damage the LC column. Modifier concentrations greater than 
10 mM are not usually necessary for chromatographic stability and can suppress ionization of 
other compounds. For best results, whenever possible, use volatile modifiers. 

Volatile modifiers include the following: 

• Acetic acid

• Ammonium acetate

• Ammonium formate

• Ammonium hydroxide

• Formic acid

• Trifluoroacetic acid

Your analyte solution can contain neutral particles or ions. If the solution contains ions, the 
ions can carry a single charge or multiple charges. The number of charges depends on the 
structure of the analyte and the composition and pH of the mobile phase. Solvent systems 
are generally composed of organic solvents, water, and volatile modifiers. The ionization 
characteristics of your analyte influence your decisions about the optimum pH of your solvent 
system and the type of probe to use at the interface of the LC and the mass spectrometer.
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With the TSQ Quantum series, LTQ series, or LCQ series instruments, you can use either the 
H-ESI probe, the ESI probe, the APCI probe, or the APCI/APPI probe at the interface of the 
LC. The choice of probe depends on the class of compound that you want to analyze and, to 
a small extent, on the flow rate of your experiment. In general, the APCI and the APCI/APPI 
probes accommodate higher flow rates and molecules of a less polar nature than does the ESI 
probe. Refer to the introduction in the documentation for your mass spectrometer for what 
factors might influence your decision about flow rates and what probe to use for optimum 
transfer of ions into the mass spectrometer.

After the ions are inside the mass spectrometer and the parent ions are isolated, collision 
energy is applied to dissociate the parent ions into product ions (MS/MS). The relative 
collision energy for a particular analysis depends on the structure of the compound that you 
are analyzing. For this reason, you optimize the collision energy on your analyte of interest in 
a tuning experiment. Refer to the documentation for your mass spectrometer for the tuning 
procedure that describes how to optimize the collision energy. 
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Quantitative Analysis Techniques
To carry out quantitative analysis, you must evaluate the instrument’s response to known 
amounts of the target component. Response is based on either the height of the 
chromatogram peak or, more commonly, the area under the peak’s profile. In both cases, you 
must take into account the baseline of the detected peak.

Instrument response is generally measured with several samples commonly called standards, 
or calibration standards. These standards must cover a suitably wide range of concentrations 
or amounts and must bracket the range of expected concentrations in the unknown. 
Responses to these standards are plotted in a graph called a calibration curve. Ideally, this 
curve corresponds to the equation of a straight line to ensure the highest degree of precision.2 

Fitting an equation to the calibration curve with a user-specified method (for example, a least 
squares regression) provides a response factor—a comparative measure of the response of 
the mass spectrometer to a component. It is based on the amount of sample injected and the 
resulting peak area or peak height. The response factor gives an intuitive and quantitative 
measure of how responsive or sensitive the mass spectrometer is to a certain component.

Figure 30. Integrated Chromatographic Peak 

To perform quantitative analysis of samples containing unknown amounts of the target 
component, calculate the peak area or height and compute and apply the appropriate response 
to the equation derived from the calibration curve. These steps provide an estimate of the 
amount of the target component in the samples. The precision of the measurement depends 
on the quality and, to a lesser extent, the quantity of the calibration data.

2Mass Spectrometry: Principles and Applications; de Hoffman, E., Charette, J., Stroobant, V.; Wiley: New York, 
1996; p 162.
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The detection limit of the quantitative analysis method is the lowest concentration of analyte 
in a sample that can be detected but not necessarily quantitated as an exact value. The 
lower and upper quantification limits are the lowest and highest concentrations of analytes in 
a sample that can be measured with an acceptable level of accuracy and precision. In an 
analytical method, the highest concentration calibration standard defines the upper 
quantification limit. 

The quantitative analysis technique you use determines the manner in which the response is 
calculated, both for generating the calibration curves and for subsequent quantitative analysis. 
The two basic methods are described in these topics:

• Using External Standards for Quantitative Analysis

• Using Internal Standards for Quantitative Analysis

Using External Standards for Quantitative Analysis

An external standard is a separate sample that contains the compound of interest at a known 
concentration in solution. In the quantitative analysis that uses external standards, a series of 
standards are analyzed and a calibration curve is constructed by plotting the magnitude of the 
detector response as a function of the external standard concentration. You analyze the 
unknown sample and determine the concentration by matching the magnitude of the detector 
response with the magnitude on the calibration curve.

Using external standards is advantageous when you are analyzing various components in a 
sample and you can assay all compounds of interest by using a single set of external standards. 
Although this approach offers time- and cost-effective quantitative analysis, it cannot achieve 
the very highest precision and accuracy. Variations in analyte and solution stability, injection 
reproducibility, and matrix interference lead to lower precision levels in the external standard 
method than in the internal standard method.

Figure 31. Calibration Curve Generated by Using an External Standard
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Using Internal Standards for Quantitative Analysis

An internal standard (ISTD) is a component that is added to a sample to act as a response 
reference for one or more non-ISTD components in the sample. The concentration or 
amount of an ISTD in any standard or unknown sample remains constant.

Because quantitative mass spectrometric analysis usually involves multiple steps, the total 
error in the analysis results from the accumulation of the errors at each step. In general, 
sample-handling errors account for a larger fraction of the total error than do 
mass-spectrometer errors. Fortunately, the internal standard method can reduce both sources 
of error. For example, internal standards can correct for variations in a component’s peak area 
that are caused by the following:

• Injection irreproducibility

• Changes in analyte solution volume

• Matrix and coeluter interference (both suppression and enhancement)

• System instability

• Variations in the source conditions

For maximum precision, add the ISTD component as early as possible to the start of the 
sample work-up, particularly in those quantitative methods that require sample manipulations 
such as extraction, cleanup, and dilution. Because the ISTD and non-ISTD components are 
analyzed together, the internal standard quantitative analysis approach has the advantage that 
it corrects for injection and other sample handling errors. The ISTD must behave chemically 
in an identical or similar manner to the target compound through the extraction, cleanup, 
and analytical processes.

You can also add the ISTD component as the last step of sample preparation prior to the 
sample’s use to compensate for fluctuations in the reproducibility of the sample injection. 

Use ISTDs in a quantitative analysis experiment as follows:

1. Analyze a series of standard solutions containing known concentrations of the target 
compound and ISTD, and plot the ratio of the target compound and the ISTD detector 
responses as a function of the corresponding ratio for the two quantities present in the 
solution.

2. Add a fixed amount of the ISTD to each sample prior to any manipulation, and, after 
preparing and analyzing the samples, obtain the quantity of the target compound present 
in an unknown sample from the calibration curve. 

Ideally, an ISTD is closely related to the target component in terms of its physical and 
chemical properties. It must be pure, not present in the sample, and inert toward the 
components of the sample. ISTD components are typically analogs, homologs, or isomers of 
the target non-ISTD component. An ideal ISTD is a structural or isotopically labeled analog 
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of one of the target components. Stable isotope-labeled ISTDs act almost identically to the 
analyte throughout sample manipulation and with regard to ionization tendencies and 
fragmentation. Internal standards labeled with two or more deuterium (D) atoms are 
frequently used for LC/MS. 

There can be any number of ISTD components in a sample, but each non-ISTD component 
can be calibrated against only one ISTD.

Figure 32. Calibration Curve Generated by Using an Internal Standard 
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Sample Types
Each quantitative analysis consists of a number, or sequence, of samples. The sequence 
represents the order of sample analysis. A quantification sequence contains:

• One or more standards

• One or more unknown samples

For more demanding applications, you can also use optional quality control (QC) samples 
and blank samples.

Standards

A calibration standard is a sample containing known amounts of all target components. The 
purpose of a standard is to measure the response of the instrument to the target components 
so that the processing software can generate a calibration curve for each component.

Unknowns

An unknown sample is one containing unknown amounts of the target components. The 
processing software performs quantitative analysis on any sample defined as an unknown 
sample. 

QCs

A QC sample contains a known amount of one or more specific target compounds. The 
processing software places QC samples in the sequence so that it can test quantitative analysis 
results for quality assurance purposes. After the QC sample is analyzed, The processing 
software compares the measured quantity with the expected value and an acceptability range. 
The quantitative analysis of a QC sample is classified as passed if the difference between the 
observed and expected quantities is within the user-defined tolerance. A QC sample is 
classified as failed if the difference between the observed and expected quantities is outside the 
defined tolerance.

Blanks

A blank sample contains no target components but might contain an ISTD when you use the 
internal standard quantitative analysis technique. By analyzing a blank sample, you can 
confirm that there are no residual components in the solvent system that can cause erroneous 
results.
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Glossary

A

absolute scaling  Displays a chromatogram trace or 
spectrum so that the height of the Y-axis scale is equal 
to the height of the largest peak in the data file. The 
height of the vertical scale is fixed for the data file 
even if you change the range of the display. 

acquisition sequence  A defined set of acquisition 
settings for a single sample or list of samples. The 
acquisition sequence includes information on how to 
acquire a sample, and whether and how to 
automatically process the sample.

adjusted retention time  The retention time (RT) of a 
component, adjusted (or normalized) using a 
retention reference component. 

See also: 
retention reference
retention time (RT)

AICA   Kaike's information criterion.

ALQ  Result is above the limit of quantitation. A user 
defines the limit.

ambiguous roots (A.R.)  If (B2-4*A*(C-Response)) > 
0, there are two roots for the equation. The Watson 
application decides which one is suitable. If both 
roots seem good, the Watson application reports A.R. 
and lets the user decide the root.

amino acid  An organic compound that contains both 
an amino group (-NH2) and a carboxyl group 
(-COOH). Twenty specific amino acids serve as the 
building blocks of peptides and proteins. These are 
the alpha amino acids that have the amino and 
carboxyl groups attached to a single carbon atom (the 
alpha carbon).

amino acid modification  A change in the mass of an 
amino acid used for a calculation. 

amino acid residue  In biochemistry, a residue is the 
portion of a molecule that remains after it has lost 
some of its components. An amino acid residue loses 
a water molecule when it is joined to another amino 
acid.

amplifier temperature   The temperature measured by 
the sensor on the RF amplifier.

analyte  A substance or chemical constituent that is 
undergoing analysis, for example, a parent drug. 

Analytical Data Interchange (ANDI) protocol  A file 
format that allows the conversion and transfer of data 
between mass spectral data systems. A file conversion 
protocol supported by the Analytical Instrument 
Association

analyte  The compound to be measured.

analytical run   A sequence of study and assay samples 
meant to be analyzed using an analytical instrument.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
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analytical run assay   Specifies the assay definition for 
each analytical run. It defines instrument interfacing 
types and styles, calibration curve and QC samples 
options, and other assay-related parameters. The 
analytical run assay is created automatically from the 
study assay whenever a new run is created. 

ANOVA  Analysis of variance.

apex RT  The retention time at which the apex of a 
chromatographic peak is located.

Area or Height Ratio  The ration of the area or height 
of the selected peak to the area or height of the 
internal standard peak.

area scan window  The number of scans on each side 
of the peak apex that you want to include in the 
calculation of peak area. The value 0 specifies that all 
scans from peak start to peak end are included in the 
area integration.

area tail extension  The number of scans beyond the 
peak endpoint on each side of the peak. ICIS uses 
this number to calculate an average for the intensity 
counts of a peak area. ICIS then uses this average 
intensity value as the lower limit of intensity and 
includes the area above this limit in the integration 
calculation for the peak.

Area Threshold   Controls the area cutoff 
automatically calculated by Avalon. Any peaks with a 
final area less than the Area Threshold are not 
detected.

area, chromatographic peak  The region of a 
chromatogram peak that is bounded by the time 
baseline and the relative abundance trace. 
Chromatogram peak areas are reported in units of 
count-seconds where the relative abundance is 
measured in counts, and the time baseline is 
measured in seconds. 

A.R (assay method)   A plan for determining desired 
test values from a subject sample. The plan includes 
definition of regression approach (method, Std/QC 
concentrations, replicates, weightings, analytes, 
internal standards), instrument to be used, 
concentration units for reporting, precision of results 
for reporting, and so on.

assay sample   An analytical run definition. A sample 
used in an analytical run that is used to determine a 
representative value from a study sample. 

ASCII  American Standard Code for Information 
Interchange.

AUC  Area under the curve.

audit log  Provides a chronological listing of all 
auditable software application events that the user 
initiated. 

auto-Dta  An auxiliary application that produces .dta 
files. 

automatic processing   The post-acquisition, off-line, 
batch (non-interactive) processing of data collected 
from the instrument. Automatic processing involves 
the use of all the methods specified in the Sequence 
for the sample(s) to be processed. 

autosampler  The device used to inject samples 
automatically into the inlet of a chromatograph. 

autozero time  The time at which the UV detector 
performs an automatic zero of the baseline. 

average molecular weight   The calculated mass of a 
molecule based on the average atomic weight of each 
element. Also known as the formula weight, for 
example, C = 12.01115, H = 1.00797, and 
O = 15.9994. 
See also: 
molecular weight

average response factor (RF)  A calibration type 
where the response factor is calculated for replicates 
at all calibration levels and then averaged. The 
amount in a sample can then be calculated by 
dividing the response by the average response factor. 

average response factor (RF) calibration curve  A 
calibration curve where the slope of the calibration 
curve is constructed from the average response factor 
(RF) of all levels. This calibration curve always passes 
through the origin. 

See also: 
average response factor (RF)
calibration curve
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Glossary: 
average response factor (RF) curve fit type  A 
calibration curve fit type where LCquan calculates a 
curve that shows its slope is constructed from the 
average response factor of all levels. 

See also: 
average response factor (RF) calibration curve
calibration curve

average spectrum  A spectrum that is the sum of all of 
the microscans taken for a particular MSn 
experiment. An average spectrum can be 
independently displayed for MS/MS, MS3, MS4, 
MS5, …MS10 experiments. The average spectrum is 
displayed normalized (NL) to the average base peak. 

averaged scans  The number of mass spectrometer 
scans that are averaged to display a spectrum from 
the data in a raw file. 

  B

base file name  A name that Xcalibur™ or LCquan uses 
when it creates the raw file for a sequence. Xcalibur 
or LCquan appends a two-digit number (01–99) or a 
three-digit number (100–999) to the base file name 
so that each sample in a sequence has a unique 
identification.

See also: 
sequence

base peak   The most intense mass peak in the mass 
spectrum. It is used as the base against which the 
intensities of all other peaks are normalized. 

base peak chromatogram  For this type of 
chromatogram, the intensity of the base peak from 
each mass spectrum is plotted as a function of time to 
form a chromatogram. 

base sample ID  An alphanumeric prefix to the sample 
ID that Xcalibur or LCquan applies to each sample 
in a new sequence. Xcalibur or LCquan adds a suffix 
to the base sample ID starting with 001. 

See also: 
sample ID
sequence

baseline  The constant signal produced by the 
background level of an instrument. In quantitative 
analysis, the base line represents the reference point 
for integration when measuring the area of any given 
peak.

baseline clipping  An integrated target peak having its 
integration line originating or terminating in a 
baseline region of no noise. A peak is considered to 
be baseline-clipped if there is no signal (that is, it is of 
zero intensity) on both sides of the peak within the 
time range. 

baseline noise  Any signal present on the base line 
represents the noise of the chromatographic system. 

baseline noise rejection factor  This factor is applied 
to the baseline peak-to-peak noise band during the 
peak detection process. 

See also: 
baseline noise

baseline type  The baseline approximation method 
used for LC chromatogram peak integration 
(Xcalibur and LCquan). 

baseline window  The number of scans for searching 
local minima.

baud rate  A measure of the number of events, or 
signal changes, that occur in 1 second.

blank sample type  A sample type that contains no 
target components. Internal standard components can 
be added to calibration blanks.
iBLQ   Result is below the limit of quantitation. A user 

defines the limit.

BMV  FDA Bioanalytical method validation guideline, 
2001.

bracket  A sequence of samples where calibration 
samples are processed before and after Unknown 
and/or QC Samples. All Calibration Samples from 
the same bracket are used for the quantitation of the 
unknown and QC samples in the bracket. 
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bracket [none]  A bracket type that can combine the 
calibration standards from the current sample set 
with previous calibration information, stored in a 
calibration file.

bracket [non-overlapped]  A bracket type where the 
unknown samples are broken into groups. Each 
group is quantified against separated sets of 
calibration standard samples. All standards are run 
before and after each group, and standards are not 
shared between groups.

bracket [open]  A bracket type showing that all 
unknown samples in the sequence are quantified 
against all standard samples of the sequence, 
regardless of the ordering of the sequence.

bracket [overlapped]  A bracket type showing the 
unknown samples broken into groups, which are 
each quantified against separate sets of calibration 
standard samples. All standards are run before and 
after each group, and standard samples between the 
groups are used to form the calibration curve for 
both groups.

bracket calibration  A calibration that runs standards 
before and after unknown samples are run. Both sets 
of calibration standard data results are included in 
the calibration curve. 

building a database  The action of creating a subset 
database from a larger database and either creating it 
separately or appending it to an existing database. 

built-in Interface   Interface software that is written 
into the Watson application code. 

Bunch Factor  The Bunch Factor is the number of 
points grouped together during peak detection. It 
controls the bunching of chromatographic points 
during integration and does not affect the final area 
calculation of the peak. 

C

CaCO2   Refers to a the Watson application assay type. 
Caco-2 is also a technique used to measure the 
permeability of test compounds through a membrane 
or barrier.  

cal level  The alphanumeric name assigned to the 
calibration level when it is created in the Component 
Calibration view of the Processing Setup window. An 
expected amount is entered for each calibration level.

See also: 
calibration level
expected amount

calculated amount  The amount present in the 
sample, as determined using the calibration curve 
and the response ratio. 

See also: 
response ratio

calibration  The process of adjusting a measurement 
system to deliver results consistent with a known 
reference.

calibration compound [mass calibration]  A 
compound whose mass spectrum is used to tune and 
calibrate a mass spectrometer. A calibration 
compound generally has a well-characterized mass 
spectrum. 

calibration curve  A calibration of sample 
concentration with a series of chemical standards at 
known concentration used as a reference point. The 
calibration curve is given with area or height response 
on the Y-axis and concentration on the X-axis.

See also: 
calibration
internal standard (ISTD) calibration
weighting (w)

calibration level  A user-specified name for all of the 
target compounds in a given calibration step. The 
individual amounts need not be the same for all 
components. 

calibration mode  The procedure LCquan uses for 
calibration. 

See also: 
update calibration mode
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calibration parameters  Instrument parameters whose 
values do not vary with the type of experiment. The 
instrument parameters that are stored in the 
calibration file. 

See also:
tune parameters

calibration replicates  Multiple injections of the 
calibration mixture at the same calibration level or 
amount. 

See also: 
calibration level

calibration sample type  One of several types that are 
used for quantification. The specific types available 
depend on the bracket type used. Examples include 
standard bracket, standard update, standard clear, 
Blank, Unknown and so on.

calibration, mass spectrometer  A compound that has 
a well-known mass spectrum used as a reference. 

See also:
calibration

cassette dosing experiment   A high-throughput 
screening procedure sometimes used in drug 
discovery to speed up assessment of pharmokinetic 
properties of compounds. Multiple compounds are 
grouped together and given to an animal. Samples 
are drawn and then the multiple compounds in each 
sample are assayed simultaneously. 

See also: 
drug set

centroid data  Data used to represent mass spectral 
peaks in terms of two parameters: the centroid (the 
weighted center of mass) and the intensity. The data 
is displayed as a bar graph. The normalized area of 
the peak provides the mass intensity data. 

See also: 
centroiding

centroiding  A method used to improve mass spectral 
data quality, get better mass assignments, and reduce 
data file size. Profile data is converted into centroid 
data by a data compression algorithm. 

See also: 
centroid data
profile data

CFR  Code of Federal Regulations.

Check calibration  A procedure that checks the MS 
detector calibration automatically. 

checksum  A calculated value that is used to test data 
integrity. It is a value calculated for a given chunk of 
data by sequentially combining all the bytes of data 
with a series of arithmetic or logical operations. 

chemical noise  Signal resulting from the presence of 
chemical species other than the analyte.

chromatogram  The graphical representation of a 
chemical separation, such as liquid chromatography, 
obtained from an analytical instrument called a 
chromatograph. The result of plotting detector 
response versus time. 

chromatographic column  A chromatographic 
separation component. A tubular column either 
filled with a finely divided solid impregnated with a 
partitioning liquid, or an open tubular column with 
a liquid film deposited on the walls.

chromatography  An analytical method that is used 
for the separation, identification, and determination 
of chemical components in a complex mixture. A 
sample is dissolved in a mobile phase (a gas or liquid) 
and then forced through an immiscible stationary 
phase. 

chromatography filter   A noise reduction algorithm 
that smooths peak profiles at low sample 
concentrations in chromatographic data. These peak 
profiles integrate more consistently than those 
acquired under normal data acquisition conditions. 

See also: 
centroid data
profile data
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comma-separated values text file  A comma-
delimited text file. The extension of a comma-
separated values text file is .csv. This file format can 
be read by a text editor program, such as Microsoft 
Notepad™, or by a spreadsheet program, such as 
Microsoft Excel™. 

complete digest  Digest type where every possible 
digest site is digested. For example, if a complete 
digest is done with trypsin, every occurrence of 
Lysine (K) and Arginine (R) will be digested.

component  An identified compound in a mixture. 

See also: 
target compound

component amount, calculated  The amount of a 
component in a solution, as determined by 
quantitation using a calibration curve. 

See also: 
calibration curve
calibration level
component amount, measured

component amount, measured  The measured 
amount of a component added to a calibration 
solution. The amount measured defines a calibration 
level for quantitation purposes. 

See also: 
calibration level
component amount, calculated

component detection  The process of identifying the 
chromatographic components in MS/MS or MSn 
sample data by extracting the mass spectral signals.

component name  The user-defined name of the 
component to be analyzed. 

composite spectrum  A spectrum that is the sum of all 
MS/MS, MS3, MS4, MS5,…MS10 spectra, as 
defined by your Instrument Method. This is not 
Normalized Spectrum.

compressibility  The compressibility of a substance is a 
measure of the reduction in its volume at a specified 
applied pressure. 

compressibility ratio  A substance is given as a ratio of 
its original volume to its new volume after applying a 
specified pressure. 

See also: 
compressibility

concentration  Refers to an analytical measurement 
reported as mass per volume or mass per mass. 
Examples are μg/mL, μM, or μg/g. Certain
the Watson application interfaces allow importation 
of concentration values from the external software. 
This occurs when a calibration curve has been 
regressed in the external software yielding back-
calculated concentration values. 

conditioning  The process used to remove surface 
contaminants from a chromatographic column.

consecutive reaction monitoring (CRM) scan type  
A scan type with three or more stages of mass analysis 
and where a particular multi-step reaction path is 
monitored. 

constrain peak width  A chromatogram peak-edge 
detection method used to integrate a peak that 
displays tailing. Xcalibur constrains the width of a 
component during peak integration using the 
specified peak height percentage and tailing factor 
parameters. A set of peak integration settings that 
constrains the peak width of an asymmetric 
chromatogram peak by excluding all or part of the 
peak. 

See also: 
peak height
tailing factor

control file  A raw file that can be compared to an 
experimental raw file during the following:

• Background subtraction to correct for the 
background signal caused by chemical noise or 
matrix effects. 

• Component detection to identify which 
components are unique to the experimental raw 
sample file. 
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control matrix  A matrix that has the same 
composition as the sample (for example, body fluid) 
but does not have the components that are being 
analyzed. A control matrix is used to filter out 
extraneous data (create a background-subtracted .raw 
file) and thereby simplify the analysis.

convex gradient curve  A gradient curve that begins 
with a large rate of change and ends with a small rate 
of change. 

See also: 
gradient curve

corrected relative retention time  The time after 
injection that it takes for a retained compound to 
elute minus the time required for an unretained 
compound to elute (void time). 

See also: 
retention time (RT)

CR   A shortened form of the phrase creep Y-axis 
normalization mode. This shortened form is used to 
save space in the header when the creep mode is in 
use. For example, CR: 1.98e+003 (1.98 x 103).

CRO   Contract Research Organization.

cross-correlation factor  MS/MS cross-correlation 
factors indicate a level of similarity between the 
reference MS/MS spectrum from a user-selected 
spectrum and the remaining MS/MS scans within 
the data file. 

cryo cooling  The use of CO2 (-70 °C) or N2 (-90 °C) 
to achieve low temperatures.

cSNPs   A single nucleotide polymorphism (SNP) that 
is found within a coding sequence. It is a small 
genetic change or variation that can occur within a 
DNA sequence. 

CTRL   Control key on a standard computer 
keyboard.  

cubic spline calibration curve  A calibration curve 
where a cubic polynomial curve is fit between each 
pair of calibration levels so that the slopes of the 
separate cubic polynomial curves match at common 
calibration curve points.

CV  Coefficient of variation.  

D

data acquisition  The process of accumulating and 
storing data received from instrument sensors as they 
detect the sample. Also, the conversion of analog 
signals to digital data files.

database  Refers to the Watson application Oracle 
database.

data bits  A group of bits—typically 5, 6, 7, or 8 bits—
used to represent a single character of data for 
transmission. The number of bits used in data 
transmission must be agreed on by the sending and 
receiving parties.

data rate  The rate of data collection by the UV 
detector.

dataset  A name that binds together related files and 
actions in the auditing database for Xcalibur. 

deconvolution  In BIOMASS Deconvolution, a 
process whereby an electrospray-ionization mass 
spectral (ESI/MS) plot of relative abundance versus 
m/z is transformed into a plot of relative abundance 
versus mass. 

delay  The time difference (in minutes) between the 
UV detector and the MS detector. The mass 
spectrometer corrects the retention time so that peaks 
from both the UV detector and MS detector appear 
at the same retention time in the data file. 

Delta Cn  Abbreviation for the difference (or delta) in 
cross-correlation score (XCorr) between the top 
candidate and the current candidate for a given input 
data file. For example, the Delta Cn for the fourth hit 
would be (Xcorr1-Xcorr4)/Xcorr1, where Xcorr1 is 
the Xcorr of the first hit and Xcorr4 is the Xcorr of 
the fourth hit.

See also: 
XCorr
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delta retention time  The difference in time between 
when a peak is expected to elute (according to 
previous run data) and when it actually elutes, 
expressed as a percentage. 

de novo sequencing  The derivation of a peptide 
sequence from its MS/MS spectrum without relying 
on protein databases for identification.

detection limit  The point at which the signal and 
noise become statistically indistinguishable. In 
practice, this is often taken as the point at which the 
amplitude of a peak is only two to three times the 
amplitude of the average baseline noise. 

See also: 
sensitivity

device(s)   A single item or items within an instrument 
(for example, pump).

digest fragments  The set of smaller compounds 
formed by the action of an enzyme on a larger 
compound. For example, the digest resulting from 
the action of the enzyme trypsin on a protein is a set 
of peptides and protein fragments. 

See also: 
enzyme
trypsin
tryptic digestion

digital  Data to/from an instrument is through either 
API calls or direct connection; this transfer type can 
be uni- or bi-directional. the Watson application's 
digital interfaces may be either built-in or gateway. 

digital  DM/PK  Drug metabolism and 
pharmacokinetics.  

dilution factor  A factor that specifies how much a 
sample was diluted during preparation. This factor is 
used to calculate the amount or concentration in the 
original (undiluted) sample. 

display range  The portion of the graph (spectrum or 
chromatogram) that is currently displayed.

dose   Protocol Definition. “The numeric amount and 
units of measure which corresponds to the level or 
concentration of a drug which is to be administered 
via the specified route of administration”. 

draw speed  The speed at which the metering unit 
draws sample out of the vial. The draw speed may 
have an influence on the injection volume precision 
when using viscous samplers. If the draw speed is too 
high, air bubbles may form in the sample plug, 
affecting precision.

driver  A device-specific control program that enables a 
computer to work with a particular device.

  droplines  A mathematically constructed vertical line 
from the valley between the peaks to the baseline. 

drug set   A group of compounds associated under a 
common name. QuickQuan uses drug set names to 
distinguish which compounds to use for each 
sequence in an assay or which compounds to tune in 
a tune plate. Using drug sets allows you to place 
multiple compounds in a vial or microplate well, for 
both tuning and acquisition. 

duplicate entries  Similar entries in a non-redundant 
protein or peptide database. 

duplicate sample   A second independent sample. A 
separate reportable result is expected for each 
duplicate sample.

DWP (deep well plate)   Ninety-six wells per plate

dynamic NSI probe assembly  The assembly that fits 
into the NSI body assembly and includes a snap-in 
tip mounting device, a fused silica emitter, a snap-in 
nut, a MicroTee™ mounting block, and a fused silica 
transfer line. 

E

early expiration  Removes peaks from the dynamic 
exclusion list if the number of times (counts) that the 
peak's intensity falls below a specified signal-to-noise 
(S/N) threshold exceeds a specified number of 
counts. The number of counts is determined during 
the full scan on which the data-dependent scans are 
based. 
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edge type  The criteria by which the left or right edge 
of a peak is detected. 

eject speed  The speed at which the metering unit 
ejects sample or solvent. A faster eject speed shortens 
the time required to run the injector program. 

end bracket sample type  The second of a set of 
calibration samples in a sequence having bracket type 
open or non-overlapped. Each set of calibration 
samples contains the standard levels defined in the 
active Processing Method. Blank samples are often 
located in the sequence before and after calibration 
samples. 

See also: 
bracket [open]
bracket [overlapped]

End S#:  An abbreviated form of the phrase end scan 
number. This is the number of the last scan that 
occurs at the selected chromatogram range end time. 
For example, if the selected chromatogram range has 
End Time = 2.46 min, this might be displayed: 
End S#: 434

See also: 
End Time
Start S#

End Time  The time (in minutes) corresponding to the 
end of the selected chromatogram range. This phrase 
is used when the end time is displayed in a header. 
For example, if the selected chromatogram range 
ends at time = 3.74 minutes, this is displayed: 
End Time: 3.74. 

See also: 
End S#:

enzyme  A biomolecule that catalyzes a specific 
chemical reaction. The enzyme does not affect the 
equilibrium of the catalyzed reaction. The enzyme 
enhances the rate of the reaction by providing a 
reaction path with a lower activation energy.

environment  Refers to the whole computer system 
(Oracle, O/S, Citrix,.NET framework, and so on.)

enzyme digest  The action of an enzyme, such as 
Trypsin, on a peptide. The enzyme breaks up the 
peptide into smaller peptides. Enzymes are site-
specific—that is, an enzyme always breaks a peptide 
at the same amino acid. For example, Trypsin attacks 
an Arginine (R) and Lysine (K).

EQB (exceeds quadratic bounds)   If (B2-4*A*(C-
Response)) < 0, there is no root for the equation, the 
Watson application reports EQB for standard samples. 
For study samples, the raw value will be analyzed to 
determine if the result is ALQ or BLQ. EQB is 
reported for quadratic and Wagner regressions only.  

error log  A file that provides a chronological listing of 
all errors that are detected while processing a sample 
or list of samples.

event  A parameter that has a time value or an assigned 
initial value, which the Avalon Peak Detection 
algorithm uses to detect chromatogram peaks. You 
can add, change, or delete events in an event list.

event list  To detect peaks, Avalon uses the settings for 
initial events and user-defined timed events in the 
event list. To calculate values for initial events, open a 
raw file, and then make the chromatogram view 
active. 

event time  The time when an external device is turned 
on or off. The time when there is a change in the 
heater temperature or valve position.

exact mass  The monoisotopic mass of a given 
compound. The exact mass is calculated by use of the 
most abundant isotopes of the constituent elements 
(for example, C = 12.0000, N = 14.00307, H = 
1.007825).

exception peak  In spectra from high resolution 
analyses, a peak (E) from an internal reference 
compound that has a known mass but is not a 
reference peak. 

See also: 
reference peak
Thermo Scientific Watson TSQ Module User Guide 127



Glossary: 
exclusion mass  A mass that is added to the dynamic 
exclusion list after the mass spectrometer obtains a 
sufficient amount of data on it. Masses in the 
dynamic exclusion list are ignored with respect to 
triggering a data-dependent scan. 

expectation value (e value)  The number of sequences 
in a database that are expected to have p scores equal 
to or better than what was observed simply by 
chance. Low expectation values represent better 
matches than high expectation values because they 
are less likely to include false positives.

expected amount  The amount entered for each 
calibration level based on the calculated amount 
from analytical measurement and subsequent 
dilution. 

See also: 
calibration level

expected RT  The expected retention time (RT) of a 
component.

See also: 
retention time (RT)

expected width  A valley detection parameter that 
defines the minimum allowable time in minutes 
between the peak apex and a valley. Valley detection 
must be enabled for this parameter to be active. 

See also: 
rise percentage
valley detection

Extensible Markup Language   See: 
XML (Extensible Markup Language)

external standard  A component (not added to the 
target sample) used to correct for instrument 
detection errors. 

See also: 
external standard calibration
internal standard (ISTD)

external standard calibration  A calibration that 
analyzes a range of known amounts of an external 
standard. Xcalibur plots the component amounts 
and their corresponding response values to create a 
calibration curve. 

See also: 
calibration
Extensible Markup Language
internal standard (ISTD) calibration

external wash  The passing of solvent through the 
syringe needle while the needle is inserted in the 
wash station.

ex vivo  In an artificial environment outside of a living 
body.

F

F  An abbreviated form of the phrase scan filter. This 
shortened form is used to save space when the scan 
filter is displayed in a header. The selected scan filter is 
displayed using the scan filter format.  

FDA  US Food and Drug Administration

file-based  Data received from or sent to an instrument 
is in ASCII or Excel file formats.  

Filter rise time  A detector parameter that controls its 
response time. The rise time is inversely proportional 
to the amount of baseline noise; the longer the rise 
time, the less noise detected. However, excessively 
long rise times can result in broader peaks with 
shorter peak heights.

firmware  Software routines stored in read-only 
memory. Startup routines and low-level input/output 
instructions are stored in firmware.

fixed Y-axis normalization mode  A display mode 
available for the Spectrum view, showing the height 
of the vertical scale set as equal to the height of the 
largest peak in the current mass spectrum. The 
height of the vertical scale is fixed when the fixed 
display mode is invoked. 
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Glossary: 
flag  Letters above chromatogram and spectrum peaks 
that provide supplemental information about the 
peak data. For example, if a peak is saturated, 
Xcalibur displays an S above the peak. 

flush volume  The volume of solvent used to flush the 
lines, sample loop, and syringe(s) between injections.

fragment length  The number of amino acids in the 
fragment.

fragment mass  The calculated sum of all the masses of 
the amino acids in the fragment.

full loop injection  A technique that injects a sample 
volume into the loop that is about twice the loop 
volume so that the loop is completely filled.

FX   An abbreviated form of the phrase fixed Y-axis 
normalization mode. This shortened form is used to 
save space in the header of the Spectrum view when 
the fixed Y-axis normalization mode is in use, for 
example, FX: 1.98e+003 (1.98 x 103).

G

gateway   Communication protocol used with the 
Watson application to add or remove interfaces. 

gateway-based interface  Interface software is a 
separate application. 

Gaussian smoothing  A smoothing algorithm that 
averages each data point with neighboring points to 
give the displayed value. A Gaussian smoothing uses 
weighting coefficients corresponding to a Gaussian 
peak shape.

GCMS (gas chromatography-mass spectrometry)
  Refers to either the assay methodology or a Watson 

application assay type. 

GCP   Good Clinical Practices.

GLP  Good Laboratory Practices.

gradient  Changes in the percentage composition of 
two or more solvents over time.

gradient curve  The shape of the solvent composition 
curve between two time lines. Gradient curves are 
determined by specifying initial and final times and 
concentrations.

Graph view file  An ASCII text file with the extension 
.grf that a user creates to save data from the Graph 
view in the Tune Plus or Tune Master window. This 
file contains n columns of information about a 
particular graph. Graph view files can be imported 
into Microsoft™ Excel for display and manipulation. 

group scan  The number of intermediate MS/MS 
scans between two MS/MS scans that have the same 
precursor m/z value. 

H

header information  Data stored in each data file that 
summarizes the information contained in the file.

HPLC (high performance liquid chromatography)
  Refers to either the assay methodology or a Watson 

application assay type.

I

ICIS  Interactive Chemical Information System

ICP-MS (inductively coupled plasma-mass 
spectrometry)  Refers to either the assay methodology 

or a Watson assay type. 

ID or Id (Identification)   Unique identifier.

incomplete digest  The digest type where not every 
possible digest site is digested. For example, if an 
incomplete digest is done with trypsin, every 
combination of digested/not digested Lysine (K) and 
Arginine (R) will be considered.

INCOS noise  A single pass algorithm that determines 
the noise level. The noise-level data is used to 
determine which peaks to label during area 
calculations and to determine peak start and peak 
end. 

See also: 
repetitive noise
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indexed database  A database created with the 
Database Manager or the FASTA Database Indexer 
to speed up searches.

individual  Specifies the number of results files 
available for each sample. One results file is created 
for each individual sample in the analytical run. 

initial temperature  The temperature of the oven or 
injector to be applied as soon as the GC receives the 
Start signal.

injection status, autosampler status  Indicates 
whether or not the current sample has or has not 
been injected. 

injection volume  The actual volume in microliters 
(μL) of a sample injected by the autosampler into the 
chromatograph. The minimum and maximum 
injection volumes that you can use depend on the 
autosampler you selected. 

input parameter files  Text files that store the settings 
used in dialog boxes. Whereas most of the settings in 
the input parameters files can be changed in the dialog 
boxes within the BioWorks Browser, some can be 
changed only by altering the contents of the input 
parameters file in a text editor.

instrument  Set of physical items that comprise an 
LC/MS system.

instrument configuration  A set of user-defined 
hardware and software options. Xcalibur provides 
configuration options for the following: mass 
spectrometer, fonts, HPLC, autosampler, inlet, 
analog inputs, and Ethernet. 

instrument method  A set of experiment parameters 
that define Xcalibur operating settings for the 
autosampler, liquid chromatograph (LC), mass 
spectrometer, divert valve, syringe pump, and so on. 
Instrument methods are saved as file type .meth. 

insulin_ms.raw  The raw spectrum of insulin that is 
provided with the BioWorks Browser program.

intensity relative to base peak  The ratio of intensity 
of a particular peak in a mass spectrum to the 
intensity of the mass peak of the greatest intensity. 
This ratio is generally equated to the normalized 
ratio of the heights of the respective peaks in the mass 
spectrum, with the height of the base peak being 
taken as 100. 

Interactive Chemical Information System (ICIS™)  
The computer software used by the Finnigan™ XSQ 
product line when running in a UNIX environment. 
You can use data obtained with ICIS software with 
Xcalibur. ICIS files have the .dat extension. 

internal standard (ISTD)  A component added to a 
sample to correct for injection errors and sample 
preparation errors. It is assumed that the ratio of the 
target compound to the internal standard compound 
is constant for a given calibration standard. The 
concentration or amount of an internal standard in 
any solution used in quantitation remains constant. 

See also: 
Extensible Markup Language
internal standard (ISTD) calibration
internal standard (ISTD) response ratio
target compound

internal standard (ISTD) calibration  A calibration 
where known amounts of standard components are 
added to the sample to be analyzed. 

See also: 
external standard calibration

internal standard (ISTD) response ratio  The ratio of 
the signal response of an unknown peak to the 
response of the corresponding internal calibration 
peak at a specified calibration level. 

interstitial volume, LC  Another name for void 
volume. The total volume of mobile phase within the 
length of the LC column. The void volume consists 
of the intraparticle volume (inside the packing 
material itself ) and interparticle volume (between the 
packing particles). The remainder of the volume of 
the column consists of the packing material.

in vivo  In the living body of a plant or an animal.
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isotopic cluster  A group of peaks that differ in m/z 
because they incorporate different isotopes of their 
component elements.

isotope search  For the analysis of unknown drugs, an 
isotope search finds extra chromatograms for each 
ion that has an intensity above a particular threshold.

isolation width   The baseline width of a window for a 
mass peak (or peak cluster) of interest for an MS/MS 
or MSn scan. 

  L

label threshold  The percent intensity value of the 
highest peak that a peak height must exceed to be 
labeled.

lactoglobulin.pep  Thermo Scientific-supplied 
peptide sequence file of -lactoglobulin.

layout  An arrangement of views and data displays that 
can be saved and opened as a file in the Qual Browser 
window. Layout files can be identified by their file 
extension: .lyt. 

level amount  The amount of a component injected 
for a specific calibration level. 

See also: 
calibration level

level name  A user-assigned name for a calibration 
level. 

See also: 
calibration level

LIMS  Laboratory Information Management System.

linear calibration curve  A linear (first order) 
polynomial least-squares fit of the experimental data 
using slope and intercept coefficients. 

See also: 
calibration curve

linear gradient curve  A gradient curve with a 
constant rate of change between solvent 
compositions.

See also: 
gradient curve

liquid chromatography/mass spectrometry 
(LC/MS)  An analytical technique that combines a 

high-performance liquid chromatograph (LC) and a 
mass spectrometer (MS). Refers to either the assay 
methodology or a Watson application assay type.

list separator character  The character used to 
separate columns of a column-separated value text 
file of extension.csv. 

locally weighted calibration curve  A calibration 
curve that is constructed from individual line 
segments. At multiple points across the calibration 
region, a weighted linear regression is performed. 
The point slopes are then connected to form a 
continuous curve. 

See also: 
calibration curve

locked workbook  A copy of a workbook (and its 
associated files) that displays “Locked” in the title bar 
and in the status bar. No processing or acquisition 
can take place in locked workbooks. The only 
functions that are allowed are those that review data 
and print reports. 

log file  A text file, with a .log file extension, that is 
used to store lists of information. 

M 

master assay  Specifies the assay definition at the 
global, system level. It defines instrument interfacing 
types and styles, calibration curve and QC samples 
options, and other assay-related parameters. A 
Master Assay is associated with a project so that 
multiple studies within a project may use it. 

master assay method  An analytical method that is 
specified as part of a project. It is handled separately 
from an actual study but is available to be associated 
with any study. A Master Assay method may be 
associated with multiple studies.
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mass   An abbreviated form of the phrase mass range. 
This shortened form is used to save space when the 
selected mass range (in mass-to-charge ratio units) is 
displayed in a header, for example, Mass: 150-375. 

massmap.params file  Stores the parameters used for 
the Peptide Mapping application. You can edit this 
file in a text editor.

mass-step size  Size of the plotting or calculating 
interval. For example, a mass-step size of 10 u would 
result in a calculation occurring at a point every 10 u 
along the baseline of the spectrum.

matrix  The material that contains the compound of 
interest (for example, blood).

mean  The average of a group of measurements (for 
example, masses, times, or intensities). The mean is 
used to calculate variance and relative standard 
deviation.

See also: 
relative standard deviation
variance

metabolic modifications  Changes that occur to 
metabolites while in the body. 

metabolite  A chemical intermediate or product due to 
metabolic reactions. 

method  A file containing commands that are 
interpreted by Xcalibur. Xcalibur uses the following 
methods to run a sample: Tune, Instrument, and 
Processing. The file extensions of these methods are 
.LCQtune or .TSQTune, .meth, and .pmd, 
respectively. Xcalibur helps you to create, edit, save, 
and use methods. 

See also: 
instrument method
processing method
Tune Method

minimum number of scans in baseline  An advanced 
parameter used to calculate a component baseline.

See also: 
baseline

minimum peak width  The value, in scans, required to 
identify that a peak exists. To be included in the list 
of found peaks, a peak must be larger than the 
minimum value.

missing component  A component that is included in 
the calibration data but is not found during the 
analysis of a chromatogram. 

modification  A chemical or structural alteration of a 
molecule, such as oxidation or methylation.

modification, mass  The mass increment associated 
with an amino acid, which you can specify to limit 
the size of a database you create.

molecular weight  The mass of a molecule calculated 
for a given molecular formula as the sum of the 
atomic weights of the constituent atoms.

monoisotopic molecular weight  The calculated mass 
of a molecule based on the exact mass of the most 
abundant isotope of each element. Use the 
monoisotopic molecular weight for all data field 
entries, for example, C = 12.000000, H = 1.007825, 
and O = 15.994915. 

mzData  An XML-based data format for storing peak 
list information, such as that contained in DTAs. 
The mzData format facilitates the comparison and 
exchange of peak list data among different platforms. 
The mzData format is developed by the PSI-MS: 
Mass Spectrometry Standards Working Group.

N

N.C.: Quadratic (not calculable using quadratic 
regression)  It is not possible to calculate using 

quadratic regression (process to find the equation of a 
parabola for a set of data). 

N.C. (non-calculable)   A general catch all when 
Watson cannot determine a value and one of the 
more specialized messages does not apply.

N.C. (Wagner)  Not calculable using Wagner 
regression.

NCA  Non-compartmental analysis
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N.D. (no data)  Data is not in Watson.

needle draw position offset  The difference in the 
distance of the needle from the bottom of the vial 
from its default position.

negative peak  A peak characterized by signal levels 
that drop below the baseline level of the detector.

neighboring amino acid  The amino acids on either 
side of the cleaved amino acid.

NL   An abbreviated form of the words normalized 
level. This shortened form is used to save space in the 
header, for example, NL: 1.98e+003 (1.98 x 103). 

nominal sample time   Protocol definition. The 
theoretical relative time a sample was taken from a 
subject after a treatment administration.

non-serial subject (sparse sampling; composite 
profile)   Protocol definition. A group of subjects that 

can be sampled only once or a limited number of 
times after treatment administration. It is not 
possible to study a subject's time vs. concentration 
profile. To create a time vs. concentration response 
profile for a treatment, a subject group dosed at the 
same time are divided into subsets of subjects that are 
sampled at different time points. Sample 
concentrations at the same time point are averaged 
together, and then the averages at the time 
increments are combined to form the time vs. 
concentration profile. 

no peak  Not calculable. No data was returned from 
the instrument for the sample or the Watson 
application is unable to calculate a solution for the 
regression. Not Reportable: user definable string User 
assigned flag. 

no sites  Amino acids in a sequence that follow an 
amino acid listed are not susceptible to digestion. For 
example, trypsin_k digests at Lysine (K), but if the K 
follows a Proline (P) in the sequence, it will not be 
digested.

no waste injection  A technique that injects the exact 
amount of sample requested. Of the three injection 
modes, the no waste injection mode uses the least 
amount of sample, but it is also the least precise. Use 
this injection mode to conserve sample. 

nominal molecular weight   The calculated mass of a 
molecule based on the integer mass number of the 
most abundant isotope of each element, for example, 
C = 12, H = 1, and O = 16. 

normal scan types  Scan types that are full and SIM. 
Normal scan types all have the same scan rate and 
provide unit resolution. 

normalization  A data analysis procedure where all 
peaks are reported with heights relative to the highest 
peak height or area in the chromatogram, spectrum, 
or map. 

See also: 
fixed Y-axis normalization mode
normalize Y-axis normalization mode

normalize spectra  The action of normalizing spectra 
to a common base peak intensity instead of using the 
raw intensities from the raw file before it generates 
correlation results.

Normalizing the spectra corrects for intensity 
discrimination in the correlation results that can 
occur if spectra with significantly different absolute 
peak intensities are used.

normalize Y-axis normalization mode  A display 
mode, which is available for the Spectrum view, that 
sets the vertical scale equal to the height of the largest 
peak in a mass spectrum. In the normalize display 
mode, the software always displays the largest peak in 
the spectrum at full scale. 

See also: 
fixed Y-axis normalization mode

nucleic acid  Biologically occurring poly-nucleotides 
showing the nucleotide residues linked in a specific 
sequence by phosphodiester bonds, for example, 
DNA and RNA.
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nucleotide  Any of several compounds that consist of a 
ribose or deoxyribose sugar, joined to a purine or 
pyrimidine base and to a phosphate group, and that 
are the basic structure units of nucleic acids.

number of scans in background  An advanced 
background subtraction parameter used to minimize 
the contaminating effect of background on the peak 
identification process when scan information is used. 

O

one-way interface  Refers to instrument interfaces that 
do not export Sample ID information. With one-way 
interfaces, matching of data in the results file to the 
Watson application worklist can be made on the basis 
of either the sequential Worklist position or the 
position on a plate.  

oligonucleotide  A short chain of usually up to 20 
nucleotides.

See also: 
nucleotide

optimization graph  The plot of mass spectrometer 
detector response for a specific device, as generated 
by the calibration procedures.

origin  The unique point on a calibration curve plot 
where zero response (Y-axis) occurs at zero amount 
(X-axis). This is the point at which the Y-axis crosses 
the X-axis. 

outlier  A calibration data point that does not appear 
to correlate to other calibration data points within 
experimental error. 

OWL  A nonredundant composite protein sequence 
database produced from the following source 
databases: Swiss-Prot, PIR 1-3, GenBank 
(translations), and NRL-3D. 

See also: 
Swiss-Prot

P

parent drug  A source compound (drug) providing one 
or more molecules or compounds. 

See also:
analyte

parity  The state of being odd or even, used as the basis 
of a method of detecting errors in binary-coded data. 
Parity must be agreed on by the sending and 
receiving devices before transmission can take place.

See also: 
full loop injection

partial loop injection  A technique that meters a 
specified amount of sample into the sample loop, 
rather than overfilling the sample loop. The sample is 
smaller than half the total volume of the sample loop

PCP  Personal computer.  

peak   A maximum in a graph of intensity versus time 
or intensity versus mass. The position of the 
maximum is said to be the position of the peak. 

peak apex   The highest point of a peak.

peak apex detection  For advanced component and 
chromatogram peak detection, the values specified 
for rise percentage and valley signal-to-noise ratio 
(S/N) serve another purpose besides valley detection. 
These values are also used during peak detection to 
determine whether or not the apex of a peak has been 
found. In this case, the tests are employed in the 
inverse of the valley detection process. 

Xcalibur uses the valley S/N value to test a possible 
apex, then applies the rise percentage value to 
confirm that the values on both sides are lower. This 
has the effect of treating a high measurement, which 
is a possible peak apex, as the crest of a hill. 
Therefore, the measurements must be lower on both 
sides of the crest when adjusted for noise. 

See also: 
rise percentage
signal-to-noise ratio (S/N)
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peak area  The area obtained by integrating peak 
intensities from the start to the end of the peak.

peak base  An interpolation of the baseline between 
the extremities of the peak. 

peak detection  The process of finding the locations 
and amplitudes of local maxima and minima in a 
signal that satisfies certain properties. 

See also: 
peak end
peak start

peak edge detection  A chromatogram peak detection 
criteria that uses the peak signal-to-noise (S/N) 
cutoff value to assist in the detection of a peak edge. 
This test assumes an edge of a peak is found when 
the baseline adjusted height of the edge is less than 
the ratio of the baseline adjusted apex height and the 
peak signal-to-noise cutoff ratio. 

See also: 
peak S/N cutoff

peak end  The end of a chromatographic peak occurs 
whenever the detection signal decreases to a value less 
than the current threshold criteria. 

See also: 
peak start

peak height  (peak dimension) The distance from the 
peak maximum to the peak base, measured 
perpendicular to the ordinate. 

See also: 
constrain peak width
tailing factor

peak integration  In this analysis of a chromatogram 
the area of each peak is determined. 

peak noise factor  The noise level multiplier used to 
determine the signal threshold of a possible peak.

peak number  An identification number assigned by 
Xcalibur to each peak in an analytical run. 

peak S/N cutoff  A peak edge detection advanced 
parameter used in conjunction with the influence of 
valley detection and baseline noise calculation. This 
test is performed based on a user-defined peak signal-
to-noise cutoff threshold. This test assumes an edge 
of a peak is found when the baseline adjusted height 
of the edge is less then the ratio of the baseline 
adjusted apex height and the peak signal-to-noise 
cutoff ratio according to the expression.

peak start  The start of a chromatograph peak occurs 
whenever the detection signal increases to a value 
greater than the current threshold criteria. 

peak symmetry  The degree to which a 
chromatographic peak exhibits a peak symmetry 
characteristic of an ideal Gaussian peak. 

See also: 
peak tailing

peak tailing  Distortion of chromatographic peaks 
from ideal Gaussian shape seen as an extension of the 
end of the signal. A tailing peak has the “T” flag set. 

See also: 
peak symmetry

peak threshold  The minimum number of intensity 
counts per sampling interval that is required before a 
signal is recorded. 

peak-to-peak resolution threshold  Controls how 
much peak overlap can be present before two or more 
adjacent peaks are recognized as a peak cluster. 
Instead of valley-to-valley baselines, peak clusters 
have baseline drops. The baseline drop of a peak 
cluster is specified as a percent of peak height overlap.

peak width  The distance across a peak measured at a 
selected peak-height level, in minutes or mass units. 
The peak-height level is usually specified as a 
percentage of the maximum peak height.

See also: 
peak width at half height
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peak width at half height  The full width of a peak at 
half its maximum height, sometimes abbreviated 
FWHM. 

See also: 
peak end
peak width

peak width, constrain  A chromatogram peak edge 
detection method used to integrate a peak that 
displays tailing. LCquan constrains the width of a 
component during peak integration using a user-
specified peak height percentage and tailing factor. 

See also: 
peak height
tailing factor

percent bias  An analytical run definition. The 
difference from nominal and observed concentration 
value.

%CV (PK  Pharmacokinetics.

percent theoretical   An analytical run definition. The 
% bias plus 100.

percent difference  The difference between the 
expected value and the calculated value is determined 
as a percentage as follows:

%Diff = 100 x (Xcalc - Xexpected) / Xexpected
where Xcalc is the calculated value of the variable X, 
and Xexpected is the expected value of the variable X.

PK/PD   Pharmacokinetic/pharmacodynamic.

plate-position-based  Specifies how the data in the 
results file are matched to the Watson application's 
analytical run. The sample in the results file is 
uniquely identified by the sample's position in the 
sample plate.

point-to-point calibration curve  A calibration curve 
that averages data at each calibration level. This 
averaging results in a single averaged data point at 
each calibration level. 

See also: 
calibration curve
calibration level

point-to-point plotting style  Style of plotting a 
spectrum that plots each intensity peak connected 
together. 

polymorphism  Genetic variation occurring within 
plant and animal species where different forms exist 
together in the same population.

polypropylene glycol (PPG)  A mixture of 
polypropylene glycols of different chain lengths used 
for high mass range calibration and tuning. A 
mixture of PPG 2000 and PPG 2700 provides ESI 
peaks suitable for calibrating over the 2000 to 4000 
mass range.

polytyrosine  Polytyrosine - 1, 3, 6 and Polytyrosine - 
1, 3, 6, 9 are the factory calibration compounds 
provided for TSQ Quantum. The polytyrosine 
mixtures contain the amino acid tyrosine and two or 
three polytyrosines, respectively. 

post processing   Procedures automatically performed 
by Xcalibur or its layered applications after an 
LC/MS run, as defined in the predefined Processing 
Method. Procedures include peak detection, peak 
integration, component identification, quantitation, 
data storage, and report generation. 

ppm  Abbreviation for parts per million. 

predefined user labels for Sequence Setup  Allows 
you to specify the values of specific parameters on a 
per sample basis in a Sequence row. These parameters 
are used for activation masses and reject masses for 
data-dependent scans and for activation masses and 
reject masses for the external trigger feature. 

predicted digest fragments  Sequence fragments 
calculated in Pepmap. Predicted digest fragments are 
the theoretical sequence fragment obtained by 
performing a hypothetical digest on the entered 
sequence.

privilege   One specific assigned security element.
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processing filter  A filter that defines the 
characteristics of a spectrum displayed in the MSn 
Browser. These filters are displayed in the MSn page 
of the Info bar in the Qual Browser window. There 
are two types of processing filters: Composite 
Spectrum processing filter and Average Spectrum 
processing filter. 

processing method   A defined set of parameters that 
provide Xcalibur and LCquan with a recipe for 
automatic quantitation and report generation. Each 
method can define single or multiple target 
compounds, single or multiple internal standards, 
and one or more undefined components. Multiple 
internal calibration levels or QC levels can be defined 
for target compounds. 

Processing Sequence  A defined set of processing 
settings for a single sample or list of samples. A 
Processing Sequence can contain unknown samples, 
calibration standard samples, quality control (QC) 
samples, and blank samples. 

product spectrum  Displays the product spectrum for 
the selected parent in the Spectrum pane. This 
spectrum consists of all of the products from the 
parent in the data that is the closest to the selected 
parent mass coordinate.

profile data   Data representing mass spectral peaks as 
point-to-point plots, with each point having an 
associated intensity value.

project   Houses studies. Each project generally has. It 
The drug or drugs used within the studies are often the 
same. When used at a CRO, it may be appropriate to 
associate sets of Studies/Sponsors together as a project.   

protein  A macromolecule composed of one or more 
polypeptide chains, each with a characteristic 
sequence of amino acids linked by peptide bonds.

protein database  A database consisting of protein 
sequences.

See also: 
protein sequence

protein sequence  The sequence of amino acids 
making up a protein.

See also: 
protein

proteolysis  The hydrolytic breakdown of proteins into 
simpler, soluble substances such as peptides and 
amino acids by proteases or intramolecular digestion.

proteome  The protein complement expressed by an 
organism’s genome.

proteome warehouse   A relational database consisting 
of a collection of proteome databases and a small 
amount of metadata. Proteome databases contain the 
shotgun annotation of all possible combinations of 
PTMs on each basic sequence in the proteome. The 
proteome warehouse stores PTM information and 
the sequence information used to identify and 
characterize proteins.

proteomics  The study of the proteome, the protein 
complement expressed by an organism’s genome.

p score  The probability of obtaining at least as good a 
match between the observed fragment list and a 
sequence as by chance. It is a measure of confidence 
in the validity of a match. A low p score means that 
the probability of obtaining at least this many 
fragments matching a sequence is low, so it is 
unlikely that random chance is the cause of the 
association.

protocol  Represents an overall plan of action for a 
study. It is defined as a set of treatments applied to 
groups of subjects where typically each group of 
subjects may receive only one or a subset of all 
possible treatments. In association with each 
treatment, the protocol also defines a schedule of 
samples to be extracted from the subjects after 
treatment and set of tests to be performed on those 
samples. There is only one protocol for a study.” 
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  Q

  quadratic calibration curve  A calibration curve 
where Xcalibur calculates a quadratic (second order) 
polynomial least-squares fit of the experimental data 
using the following mathematical form: 
Y = AX2 + BX + C

where A, B, and C are the polynomial coefficients.

See also: 
calibration curve

quadratic limit   If (B2-4*A*(C-Response)) = 0, there 
is only one root for the equation. That is conc = -B / 
(2*A).  

quadratic log-log calibration curve  A calibration 
curve that calculates a quadratic (second order) 
polynomial least-squares fit of the experimental data. 

See also: 
calibration curve

qualitative analysis   Chemical analysis designed to 
determine the identity of the components of a 
substance. 

See also: 
quantitative analysis

quality control (QC)  A quality management program 
that includes procedures designed to ensure a 
specified level of process quality. Calibrations, 
duplicate or replicate analyses, spiked samples and 
blanks are quality control activities. The accuracy 
and precision of QC sample results are used to 
indicate the accuracy of the quantitation of unknown 
samples. 

See also: 
quality control (QC) sample type
unknown sample type

quality control (QC) sample type  A sample that 
contains known amounts of known components. 
QC samples are placed in the sequence so that 
quantitation results can be compared with known 
component amounts or concentrations for quality 
assurance purposes. 

See also: 
quality control (QC)

quantitation  The process of determining the amount 
of a component in a sample.

quantitation mass   A specific mass-to-charge ratio 
(for example, m/z 502) or range of mass-to-charge 
ratios to be used when determining the peak area and 
peak height of a compound. Usually, a quantitation 
mass (quan mass) is chosen that is characteristic of 
the compound. 

See also: 
peak area
peak height

quantitative analysis   Chemical analysis designed to 
determine the quantity or concentration of a specific 
substance in a sample.

See also: 
qualitative analysis

Quantitative calibration  The process of determining 
how the LC/MS system responds to different 
compounds. Quantitative calibration involves 
designing a processing method and performing 
calibration experiments with calibration standards 
containing known quantities of analyte.

R

R2 (R squared)  A “goodness of fit” calculated for 
calibration curves. A goodness of fit of 1.0 indicates 
that the calibration curve passes through each data 
point exactly. The closer the goodness of fit value is 
to 1.0, the better the calibration curve fits the data. 

ramp  The rate of change from one temperature, 
pressure, or flow to the next.

raw amount  The unadjusted amount of a component, 
as determined from a quantitation analysis or by the 
application of a response factor. 

raw data  Uncorrected liquid chromatograph and mass 
spectrometer data obtained during an acquisition. 
Xcalibur and Xcalibur-based software store this data 
in a file that has a .raw file extension. 

raw instrument response   An analytical run 
definition. The value, either direct from instrument or 
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derived, which is used to perform the regression. 
Examples of instrument responses include: peak area, 
peak height, ratio of peak Areas, ratio of peak heights.  

real time   A data acquisition method that generates 
and displays the mass spectra as the experiment is in 
progress. 

real-time plot  A plot of a mass spectrum or 
chromatogram that displays the data as it is generated 
by the mass spectrometer. 

See also: 
real time

reference compound  The internal standard for a 
given target compound. 

reference mixture  For internal standard calibration: A 
solution that contains one or more internal standard 
(ISTD) and target compound. For external standard 
calibration: A solution that usually contains the 
target compound(s). 

See also: 
internal standard (ISTD)
target compound

reference peak  In spectra from high resolution 
analyses, a peak (R) from an internal reference 
compound that has a known, precise mass. Reference 
peaks are used as measures of calibration accuracy. 

See also: 
exception peak

regression calculation  A least-squares method of 
obtaining a mathematical equation that best fits a set 
of experimental calibration data. Xcalibur and 
LCquan support linear, quadratic, and cubic 
regression calculations. 

related peaks  Peaks in a mass spectrum that are 
produced by fragments of a common compound.

relative intensity  The ratio of the intensity of a 
specific peak to the intensity of the peak with the 
highest intensity. 

relative peak height threshold  A threshold that 
excludes all peaks whose height falls below a specified 
percentage of the height of the highest peak in the 
chromatogram.

relative retention time (RRT)  The LC elution time of 
a component divided by the elution time of a 
reference component. The ratio of the LC elution 
time of a retained component (t) corrected for the 
void time, tvoid, and the elution time of a reference 
component, tref, corrected for the void time: 
RRT = [t - tvoid]/[ tref - tvoid]. 

See also:
corrected relative retention time
void time

relative scaling  Displays a chromatogram trace or 
spectrum so that the height of the Y-axis scale adjusts 
to the peak heights of the data currently displayed.

relative standard deviation  A measure of the 
dispersion of a group of measurements relative to the 
mean of the group. Relative standard deviation is 
expressed as a percentage of the average value. The 
percent relative standard deviation is calculated as:

%RSD = 100 (S / )

where S is the standard deviation and is the 
sample mean. 

See also: 
standard deviation

repetitive noise  A multiple-pass algorithm that 
determines the noise level. The software uses the 
noise-level data to determine which peaks to label 
during area calculations, and to determine the peak 
start and peak end. 

See also: 
INCOS noise

replicate   An aliquot of the same sample, only a single 
reportable result is expected for replicate samples.  

RESID database  A database of annotations and 
structures for protein modifications.
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reservoir vial  With a 12 mL capacity, the reservoir vial 
is used to hold solvent, reagent, or diluent. Up to 
four of these large vials can be fitted behind the wash 
station. A reservoir vial is approximately the same 
height as a sample vial.

resolution, chromatographic  A measure of the ability 
of a chromatography column to separate components 
during a chromatographic experiment. 

response factor  A calculation coefficient that corrects 
for the different response of the instrument to 
different compounds. The response factor is used in 
quantitation to convert peak areas to numbers 
proportional to the weight of sample. 

response ratio  The numerical value of the 
Response/ISTD Response. If the Response is 
specified as Area in the processing method, then the 
units of both Response and ISTD Response are 
counts-sec. If the Response is specified Height in the 
processing method, then units of both Response and 
ISTD Response are counts. 

See also:
calculated amount

response value  The signal from the mass spectrometer 
detection of a component peak as it elutes from an 
LC column. Xcalibur and LCquan can use either the 
peak area or peak height to record the response to a 
specific component. 

result file  The file containing the data that resulted 
from the analysis of a raw data file. Each analyzed 
run has both a raw (data) file of type .raw and a result 
(data) file of type .rst. 

Results Table  The name given to the table of data in 
the DeNovo and Peptide Mapping applications. 
DeNovo: contains the list of candidate sequences and 
scores. Peptide Mapping: contains the list of results 
from the Peptide Mapping search.

retention reference  A calibration standard whose 
retention time is used to adjust the retention time of 
other components in the same run or to calculate 
their relative retention times. Also known as 
calibration reference, reference component, retention 
reference component, and internal standard. 

See also: 
relative retention time (RRT)

retention time (RT)  The time after injection at which 
a compound elutes. The total time that the 
compound is retained on the chromatograph 
column. 

retention time shift  For each compound in a method, 
there will be a predicted retention time (RT) for the 
quantitation mass peak. This predicted RT will be 
determined by the SOP definition of predicted RT. It 
can change from day to day or between batches 
because it is a function of column maintenance. 

RF   See:
response factor

RIA (radio-immuno assay)  RIA refers to either the 
assay methodology or a Watson application assay 
type. 

ring electrode  The mass analyzer electrode that is 
located between the endcap electrodes. 

rise percentage  An advanced parameter used for both 
valley detection and peak detection.

rise time  A parameter that controls the response time 
of UV-Vis or PDA detector. The rise time is inversely 
proportional to the amount of baseline noise. For 
example, the longer the rise time, the less noise 
detected.

role  A role is a set of assigned security privileges.

route of administration   Protocol Definition. The 
means by which a drug enters into a subject. For 
certain types of administration, the drug is infused over 
a significant length of time. In these instances, the 
duration of administration is usually recorded”.  

RT  An abbreviated form of the phrase retention time 
(RT). This shortened form is used to save space when 
the retention time (in minutes) is displayed in a 
header, for example, RT: 0.00-3.75.

See also: 
retention time (RT)
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S

S#   An abbreviated form of the phrase scan number. 
This shortened form is used to save space when the 
scan number is displayed in a header, for example, 
S#:234.

See also: 
scan number

sample  A quantity of material (for example, plasma).

sample data type   Protocol definition. Meaning of the 
sample type that can be one of two values; either 
point or interval. A blood sample is considered a 
point sample data type because the analyzed value 
from a blood sample corresponds to drug 
concentration in the blood at a particular point in 
time. A urine sample is considered an interval sample 
data type because the analyzed value form the sample 
must be considered in terms of the sample volume 
and the time between samples to accurately represent 
elimination of an analyte. 

sample handling  Defined as those activities that relate 
to handling of actual samples extracted from subjects as 
part of the study's protocol at the experimental site.   

sample ID  An alphanumeric string of characters that 
uniquely identifies a sample. Sample IDs are entered 
using the Sequence window. 

sample ID-based  Specifies how the data in the results 
file are matched to the Watson application's analytical 
run. The sample in the results file is uniquely identified 
by the sample's unique ID that is generated by the 
Watson application.  

sample loop  A loop of calibrated volume that is used 
to perform flow injection analysis. 

sample type  Protocol definition. Any tissue or 
biological fluid taken from a subject for analytical 
testing in order to determine the effects of a drug 
treatment. Every different kind of sample will be 
assigned a biological matrix type.

A sample category tells Xcalibur or LCquan how the 
data for a particular sample is to be processed. 

sample volume  The Sample Volume column of a 
sequence is used to calculate concentrations from 
amounts or amounts from concentrations. 

saturation (sat.)  A measure of the “purity” of the hue. 
As saturation is decreased, the hue becomes more 
gray. A saturation of zero results in a grayscale value.

SB  An abbreviated form of the phrase subtract 
background. This shortened form is used to save space 
in the header when indicating the number of 
background scans subtracted from a Spectrum 
display, for example, SB: 30. 

scan description  A symbolic code used to describe the 
scan event settings for a specific scan event. 

scan event   A mass spectrometer scan that is defined 
by choosing the necessary scan parameter settings. 
Multiple scan events can be defined for each segment 
of time. 

scan filter  Created by Xcalibur from instrument 
method settings, a scan filter specifies that processing 
is to be applied to a subset of the scans in a raw file. 

In the Qual Browser window: The autofilter feature 
can be used to display chromatogram traces for each 
scan filter. In addition, filters are automatically 
transferred to the target display when data is selected 
graphically. You can also drag a filter onto a graph 
from a Scan Filter display.

scan number  A number assigned to each scan that 
identifies the relative order when it was acquired in a 
mass spectrometer run. 

scan power  The power n in the expression MSn. The 
number of stages of mass analysis, expressed as MSn, 
where n is the scan power. For example, a scan power 
of n = 1 corresponds to an MS1 (or MS) scan with 
one stage of mass analysis. A scan power of n = 2 
corresponds to an MS2 (or MS/MS) scan with two 
stages of mass analysis. A scan power of n = 3 
corresponds to an MS3 scan with three stages of mass 
analysis, and so on.

scan range   The range of mass-to-charge ratios over 
which the mass spectrometer is scanned. 
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scan rate  The rate at which the quadrupole mass 
spectrometer scans the specified scan range, in units 
of u per second.

scan time (ST)  The amount of time required to 
accomplish one scan, from the lowest mass to the 
highest mass of a specified scan range. The scan can 
be continuous (full-scan type) or it can be in 
segments (SIM and SRM, for example).

scan width  The width of the scan range, in m/z units. 
When you use a center mass/scan width input 
method to define the scan range, the scan range is 
centered symmetrically about the specified center 
mass.

search window  A time range or mass range to limit a 
search for similar scans.

segment  A period of time during a mass spectrometer 
run.

semi-automatic calibration   A procedure that 
calibrates the MS detector automatically, one or more 
parameters at a time. 

See also: 
calibration parameters

sensitivity  The signal obtained per amount of sample 
introduced. Different measures of sensitivity are 
recommended, depending on the nature of the 
sample and the required inlet system. 

See also: 
detection limit

septum purge flow  The flow, in mL/min, from the 
septum purge line, which sweeps out any residual 
sample after sample injection. 

sequence  The series of samples (rows) selected for 
analysis. 

sequence file  A file that you create that provides 
instructions about how to run a sample or list of 
samples. 

sequence length  The number of amino acids in a 
peptide. 

See also: 
amino acid

serial port  An input/output location (channel) for 
serial data transmission.

set mass   The mass of interest. It depends on the scan 
mode chosen.

For the Product scan mode, the set mass is the parent 
mass. 

For the Parent scan mode, the set mass is the product 
mass.

For the Neutral Loss scan mode, the set mass is the 
neutral loss mass.

set point   The set of a mass-to-charge ratio and its 
associated value (such as a voltage) used to define a 
tuning table for a device. A set point is created by 
having TSQ Quantum optimize a device for a 
specific mass. 

shipment sheet  Sample Handling definition. The 
document the accompanies a sample shipment. It 
describes the samples in the shipment.  

shotgun annotation  The overpopulation of a database 
by all combinations of all known modifications to a 
protein's basic sequence. Shotgun annotation 
calculates all possible combinations of known post-
translational modifications (PTMs) onto each 
protein sequence.

shutdown method  An Instrument Method that is run 
by Xcalibur or LCquan after it runs the last sample in 
an acquisition. You create Shutdown Methods in the 
Instrument Setup view. 

signal-to-noise ratio (S/N)  The ratio of the signal 
height (S) to the noise height (N). The signal height 
is the baseline corrected peak height. The noise 
height is the peak-to-peak height of the baseline 
noise. 

See also: 
signal-to-noise ratio threshold
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signal-to-noise ratio threshold  A user-specified 
chromatogram peak edge detection criterion used for 
peak integration. 

sites  Specific amino acids that are attacked by the 
enzyme listed.

slit width  The width of the variable slit at the entrance 
of the spectograph. Use a narrow slit for analytes with 
very fine structures in the absorbance spectrum and 
for high concentrations. Use a wide slit to detect very 
low concentrations.

smoothing  The application of a smoothing algorithm 
to the data to improve the graphical appearance of 
data by reducing the level of noise and/or to improve 
peak detection. Xcalibur provides the following types 
of data smoothing: boxcar smoothing and Gaussian 
smoothing. improves the graphical appearance of 
data by reducing the level of noise and/or to improve 
peak detection.

smoothing points  The odd integers from 1 (number 
of points) to 15 used in a weighted average to reduce 
the level of noise in the data, consequently improving 
peak detection and the graphical appearance of the 
data. 

See also: 
smoothing

SNP  A single nucleotide polymorphism, which is a 
small genetic change, or variation, that can occur 
within a DNA sequence. 

solute  A dissolved substance. The dissolved 
component of a mixture that is to be separated in a 
chromatographic column. (Also called the sample or 
analyte.)

SOP  Standard Operating Procedure.

Sp  Abbreviation for the preliminary score of the top 
candidate peptide or protein for a given input data 
file.

spectral trees  A representation of the data structure of 
MSn spectra. A tree, which is like a structural 
“fingerprint”, reflects the hierarchical spectra 
dependencies in MSn experiments. For more details 
on spectral trees, see the Help in Mass Frontier™. 

spectrum averaging  The averaging of spectral data for 
a number of scans. 

stability samples   An analytical run definition. Used 
to analyze the reliability of quality control samples over 
time.  

standard bracket sample type  The calibration 
samples in a Sequence having bracket [open] or 
bracket [overlapped] type. 

See also: 
bracket [open]
bracket [overlapped]

standard deviation  In statistics, the standard 
deviation is a measure of the dispersion of a group of 
measurements. For example, masses, times, or 
intensities. Standard deviation is calculated as 
follows: 

where Var (Xi...XN) is the variance. 

See also: 
relative standard deviation

Standard Error of the Mean (SEM)  An analytical run 
definition. SEM is Standard Deviation divided by the 
square root of n.  

standard sample   A sample with a known amount of 
calibration reference material. 

standard update sample type  Xcalibur adds this 
sample type to the calibration curve without 
removing previous entries. The first calibration 
sample in a Sequence having bracket [none] type is a 
standard clear type. Xcalibur clears all previous data 
for all calibration levels and begins a new set of 
calibration data. Xcalibur assigns all subsequent 
samples in the same calibration sequence to be the 
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Standard Update Sample Type. The calibration data 
set consists of the data from the standard clear 
samples and the data from the standard update 
samples. 

See also: 
bracket [none]

start bracket sample type  The first of a set of 
calibration samples in a Sequence having bracket 
[open] or bracket [overlapped] type. Each set of 
calibration samples contains the standard levels 
defined in the active Processing Method. Blank 
samples are often located in the Sequence before and 
after calibration samples. 

See also: 
bracket [open]
bracket [overlapped]

start delay   A time delay (in minutes) before the start 
of acquisition. 

Start S#   An abbreviated form of the phrase start scan 
number, which is the mass spectrometer scan number 
that occurs at the selected chromatogram range start 
time. This shortened form is used to save space in the 
header of the Spectrum view. For example, if the 
selected chromatogram range includes start time = 
0.00 minutes, this is displayed: Start S#:1. 

See also: 
End S#:

start time  The time (in minutes) corresponding to the 
beginning of the selected chromatogram range. This 
phrase is used when the start time is displayed in a 
header. For example, if the selected chromatogram 
range starts at time = 0.0 minutes, this is displayed: 
Start Time: 0.0. 

See also:
End Time
Start S#

startup method  An Instrument Method that is run by 
LCquan Xcalibur before it runs the first sample in an 
acquisition. You create Startup Methods in the 
Instrument Setup window.

static nanospray   A device that performs continuous 
analysis of small analyte solution volumes over an 
extended period of time. 

static NSI probe assembly  The assembly that fits into 
the NSI body assembly and includes the static 
nanospray probe tip, the nose cone tip mount, and 
the probe body assembly. 

stick plotting style  Style of plotting a spectrum that 
plots each intensity peak as a vertical line.

See also:
point-to-point plotting style

stop bits  A bit that signals the end of a character.

structure elucidation  A process that determines both 
the molecular formula (the number of atoms of each 
type in a molecule) and the molecular structure (the 
order showing how the atoms are connected to each 
other). The MS/MS scan modes are powerful tools 
for elucidating the structure of organic compounds. 

study (LCquan)  A folder that contains one or more 
LCquan workbooks for a specific analytical 
experiment. 

See also:
workbook

study (Watson)  Determines the interaction of a drug 
with test subjects (animals or man) which have been 
administered that test article (drug). Based on a plan 
for subject dosing followed by subject sampling. The 
samples obtained from the subject via a variety of 
biological matrices are then analyzed for drug levels 
according to an analytical method. Results of this 
analysis are then stored for further analysis and 
reporting in terms of the protocol. 
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study assay  Specifies the assay definition at the study 
level. Defines instrument interfacing types and styles, 
calibration curve and QC samples options, and other 
assay-related parameters. The Study Assay is copied 
from the master Assay. 

study sample  An analytical run definition. A sample 
from a subject at a treatment site that is based on the 
study's protocol.

study samples database  The sample-by-sample 
representation of the study. Every sample in this 
database must be represented individually or as part 
of a group in the study.

subject   Protocol definition. A living biological entity 
that can be administered a dose of a drug and 
subsequently sampled for purposed of analyzing drug 
activity. 

subject group  Protocol definition. A set of subjects 
which have a common set of treatment 
administrations applied to them. 

summary  Specifies the number of results files available 
for each analytical run. One results file is created for all 
samples in the analytical run.   

Swiss-Prot  Part of the UniProt database, an annotated 
protein sequence database maintained by the Swiss 
Institute for Bioinformatics (SIB) and the European 
Bioinformatics Institute (EBI). The Swiss-Prot 
database consists of protein sequence entries.

T

T  Time  

T-Half  Half life

tailing factor  A peak integration parameter that 
constrains the peak width of an asymmetric 
chromatogram peak that has a tailing trace. 

See also:
constrain peak width
peak height

tangent skim  A timed event that you can specify in 
the event list shown with the Avalon Peak Detection 
algorithm. Tangent skim identifies the tallest peak in 
a cluster and detects peaks on either side or both 
sides of the tallest peak. Tangent skim resets 
automatically at the end of a peak cluster.

target compound  A compound that you want to 
identify or quantitate or that a specific protocol (for 
example, an EPA method) requires that you look for. 
Target compounds are also called analytes, or target 
analytes. 

tension  Controls how closely the baseline follows the 
overall shape of a chromatogram. A low tension 
traces the baseline closely to follow changes in the 
chromatogram. A high tension follows the baseline 
loosely and over longer time intervals.

See also:
baseline

threshold  A value above which something will take 
place. For example, if a peak height is above the 
indicated peak label threshold, that peak is labeled.

threshold base peak  Indicates that peaks below this 
percentage of the base peak will not be plotted. 

time function (TF) programming  The process of 
turning external devices (such as column-switching 
valves and fraction collectors) on or off at preset 
times during your run. To create a time program, fill 
in the Time Events table.

time offset  The value that adjusts for fluctuating 
retention times when comparing data between the 
experimental source raw file and the control 
background file.

time programming  The process of changing the 
heater temperature or valve position at preset times 
during your run. To create a time program, fill in the 
Time Program table. 

timed event  An instrument action triggered to occur 
at a specific, preset time during a run or analysis.
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tolerance  The allowable range of deviation from a 
specified value, expressed as a percentage of this 
nominal value. 

total composite spectrum  A spectrum that is the sum 
of all MS/MS, MS3, MS4, MS5,…MS10 averaged 
spectra. 

trace  A record made by an instrument’s recording 
element. A common term for a chromatogram.

See also:
chromatogram

treatment (treatment administration)   Protocol 
definition, per 21 CFR Part 11, “The actual event of 
administering a drug dose via a route of 
administration to a group of subjects”.

treatment group   Protocol definition. The same set of 
subject who have been administered a treatment.

treatment site   Sample Handling definition. The 
location at which subjects are dosed and sampled. 

triple stage quadrupole (TSQ™) mass spectrometer  

A tandem MS/MS instrument, which has the first 
and third quadrupoles performing mass analysis, and 
the second quadrupole (operated in RF-only mode) 
functioning as an ion transmission device. 

trypmyo01.raw  A raw spectrum file of the tryptic 
digest of myoglobin.raw.

See also:
mzData

trypsin  A proteolytic enzyme found in pancreatic juice 
and active in alkaline environments.

tryptic digestion  The site-specific breakdown of a 
protein or peptide into smaller fragments of amino 
acids by use of the enzyme trypsin. 

See also:
digest fragments
trypsin

TSQ™ mass spectrometer  See:
triple stage quadrupole (TSQ™) mass spectrometer

Tune Method  A defined set of mass spectrometer tune 
parameters for the ion source and mass analyzer. 
Tune methods are defined by using the Tune Plus 
(LCQ Series, LXQ, and LTQ) or Tune Master (TSQ 
Quantum) window and saved as the file type 
.LCQTune, .LTQTune, or.TSQTune, respectively.

A tune method stores tune parameters only. 
(Calibration parameters are stored separately, not 
with the tune method.)

tune parameters  Instrument parameters whose values 
vary with the type of experiment. 

tune plate   A plate of compounds separated into 
different wells/vials. Each well represents compounds 
grouped together as a drug set. 

tune, mass spectrometer  Tuning the mass 
spectrometer involves optimizing voltages, currents, 
flows, and so on for the ion source parameters to 
achieve optimal mass spectral sensitivity and proper 
resolution. 

tune, MS detector, automatic  A procedure that 
automatically tunes the mass spectrometer. 

See also:
tune, MS detector, manual
tune, MS detector, semi-automatic

tune, MS detector, manual  A process that lets you 
manually tune the mass spectrometer one parameter 
at a time. 

See also:
tune, MS detector, manual
tune, MS detector, semi-automatic

tune, MS detector, semi-automatic  An automatic 
procedure that tunes the mass spectrometer one 
parameter at a time. 

tuning and calibration solution  In the TSQ 
Quantum, the standard ESI tuning and calibration 
solutions are polytyrosine mixtures, Polytyrosine –
1, 3, 6 and Polytyrosine – 1, 3, 6, 9. 

two-way interface   Refers to instrument interfaces 
that export sample ID information. With 
bidirectional interfaces, matching of data in the 
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results file (or external application for a digital 
interface) to the sample in the Watson application 
worklist is made on the basis of the results being 
tagged with the Sample ID. 

  U

undefined component  Any component that is not 
defined as a target compound or an internal standard 
compound. This is the default component type. 

unidentified peak  A peak in an LC chromatogram or 
mass spectrum that is not identified. Sometimes 
called an unknown peak

uni-directional interface  .

UniProt  An international repository of organisms 
containing all the proteins and genes that are known 
for a specific organism.

unknown sample type  A sample type that is not a 
Calibration Sample, Calibration Blank, Quality 
Control Sample, or Quality Control Blank. 

unresolved peak  A peak that overlaps the previous or 
next peak. A peak that starts or ends at a valley above 
the baseline. 

update calibration mode  A calibration mode where a 
new data point is added to the calibration curve. 

User Account   The mechanism by which the Watson 
application identifies different users of the 
application. An account contains the formal name 
for the User. This name will be used for all reports 
generated by the system. The account also contains 
the name and password the user will use when 
logging into the application.

V

valley detection  A chromatogram peak edge detection 
method used to integrate unresolved peaks. Xcalibur 
and LCquan drop a vertical line from the apex of the 
valley between unresolved peaks to the baseline. The 
intersection of the vertical line and the baseline 
defines the end of the first peak and the beginning of 
the second peak. 

See also:
expected width
rise percentage

variance  A statistical variance of a data set is used to 
calculate standard deviation and relative standard 
deviation. Variance is calculated:

where N is the number of samples, Xi is the value of 

each individual sample, and is the mean of the 
sample value.

See also:
mean
relative standard deviation
standard deviation

v  Version.  

vial list  A list that contains the vial number, sample 
type, level, sample ID, and sample name for each vial 
in a sequence. The list is organized by ascending vial 
number.

vial position  The vial position in the autosampler tray 
of the current sample. Also called the vial number.

view width  The duration of time (in minutes) that 
Xcalibur or LCquan displays for a chromatogram 
view. A view width can be specified for each 
component. 

void time   The time after injection that it takes an 
unretained compound to elute from the LC column. 
This time is subtracted from the elution time for a 
retained compound to obtain the corrected relative 
retention time for the elution of each compound. 
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  W

W   An abbreviated form of the word weighting (W:). 
This shortened form is used to save space in the 
header of the Spectrum view when the calibration 
curve data weighting factor is displayed. For example: 
W: xxxx, where xxxx is the weighting option selected 
and stored in the Processing Method.

See also:
weighting (w)

weight  In Xcalibur and layered applications, this is 
equivalent to mass.

weighting (w)  The mathematical assignment of 
significance (weight) to specific points during a least-
squares regression analysis calculation. A weighting 
of one indicates equal weighting and treats each 
point the same in the regression calculation. 

window size  The number of scans in the window used 
during peak identification by the spectrum method.

WMF   Windows Meta File.

workbook  A folder in an LCquan study that contains 
Instrument Methods, Sequences, Processing 
Methods, and raw files for an acquisition. Each 
Workbook contains folders named Exports, Imports, 
and Raw files. 

See also:
locked workbook
study (LCquan)

workgroup   A set of users assigned to specific roles. 

work list  A set of samples to be submitted to the 
instrument,

work list-based  specifies how the data in the results 
file are matched to the Watson application's analytical 
run. The sample in the results file is uniquely identified 
by the sample's position in the Watson application 
worklist.  

X

XCorr  Abbreviation for the raw cross-correlation score 
of the top candidate peptide or protein for a given 
input data file.

XML (Extensible Markup Language)  A general-
purpose markup language that is used to facilitate the 
sharing of data across different information systems, 
particularly via the Internet.
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